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Introduction

Welcome to the Mastercam Basics Tutorial. This tutorial helps you explore Mastercam'’s interface and learn basic
concepts of the software. This tutorial includes the following:

e Abroad look at the Mastercam interface

« An introduction to Mastercam’s File menu, also known as the Backstage

An introduction to creating and managing levels and planes
» An exploration of solid and wireframe chaining
e Anintroduction to creating toolpaths

Tutorial Goals

Understand basic Mastercam functions

» Customize a configuration file and Mastercam’s interface for your working style

» Chain geometry and create toolpaths for your part

Manipulate Mastercam’s graphics window, levels, and planes to view your part

General Tutorial Requirements

& WARNING:

This tutorial is for educational purposes only. We have not verified the values and settings in this tutorial
with our machines or tools. Do not use the values in this tutorial to cut parts without proper verification
and testing for your environment.

@ NOTE:

Screen colors in the tutorial pictures were modified to enhance image quality; they may not match your
Mastercam 2025 settings or the tutorial results. These color differences do not affect the exercises or your
results.

Estimated time to complete this tutorial: 5 hours
All Mastercam 2025 tutorials have the following general requirements:

* You must be comfortable using the Windows® operating system.
 Ifyou are completing this tutorial using Mastercam Learning Edition, you will be unable to post code.

» Each lesson in the tutorial builds on the mastery of the preceding lesson's skills. We recommend that you
complete them in order.

» Additional files may accompany a tutorial. Unless the tutorial provides specific instructions on where to place
these files, store them in a folder that can be accessed from the Mastercam 2025 workstation, either with the
tutorial or in any location that you prefer.
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* You will need an internet connection to view videos that are referenced in the tutorials. All videos can be
found on our YouTube channel: www.youtube.com/user/MastercamTechDocs

» All Mastercam tutorials require you to configure Mastercam to work in a default Metric or Inch configuration.
The tutorial provides instructions for loading the appropriate configuration file.


http://www.youtube.com/user/MastercamTechDocs

Mastercam'’s ribbon interface is based on standard Windows design guidelines. The ribbon comprises familiar
controls, including a Quick Access Toolbar (QAT), tabs, contextual tab groups, galleries, buttons, and the Backstage.
It also features special on-screen controls, and movable, dockable Managers and function panels.

This section briefly touches on the elements that make up the Mastercam interface to give you a better
understanding of how to use these elements to create and machine your parts.

Chapter 1

Mastercam Interface Overview

Goals

Explore Mastercam's interface.

Customize the Quick Access Toolbar.

Access Mastercam resources.

Configure entity attributes.

Understand Selection Bar, AutoCursor, and Fast Point.
Use Quick Masks.

Explore the Status Bar.

Exercise 1: Exploring Mastercam’s Interface

Start Mastercam using your preferred method:

Double-click Mastercam's desktop icon.
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Or,

Launch Mastercam from the Windows Start menu.
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The following image displays the elements that make up the Mastercam interface. The corresponding sections
provide brief descriptions of each element and its use.
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1. Quick Access Toolbar (QAT): A customizable set of commonly used functions that are always available in the
interface. The QAT can be located above or below the ribbon.

2. Tab: Groupings of related controls. Tabs are organized in a simple-to-complex workflow from left to right.
3. Tab Group: A region of the tab that contains a set of related controls.

4. Contextual Tab: A tab that displays when you make a specific selection in Mastercam. A contextual tab
presents controls and commands relevant to your current activity.

5. Tooltip: A small window with descriptive text that displays when you hover over a command or control.

6. Selection Bar: A toolbar that combines AutoCursor controls and general selection tools used to select
entities in the graphics window. There are two selection modes, Standard Selection and Solid Selection, that
are activated based on the function you are using. AutoCursor controls allow you to detect and snap to
locations as you move the cursor over geometry in the graphics window. AutoCursor becomes active
whenever Mastercam prompts you to select a position in the graphics window.

7. Quick Masks: A group of controls that helps you to select all entities of a certain type, or to select only
entities of certain type. Most Quick Mask controls are divided in half. Clicking the left or right side of the
control toggles between selection modes. When a Quick Mask control is selected it highlights to indicate the
selection mask is on. You can toggle multiple Quick Masks at a time.

8. Status Bar: A bar across the bottom of the workspace that shows the coordinate position of the cursor and
provides quick access to modify planes, construction mode, and Z depth. The right side of the Status Bar has
wireframe, shading, and translucency controls that change the appearance of your part. The left side of the
Status bar indicates the number of selected entities and the status of Section View.

SECTION VIEW: OFF  SELECTED ENTITIES: O % -5.0009 ¥ 082856 Z 000000 - 3D CPLANE:Top - TPLANE:Top - WCS:Top & @ 9 @ e 7
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9. GView Cube: An augmented and more graphical way to show part and plane orientation. Click directly on the
different faces and sides of the cube to control the view and on-screen orientation of your part. The Gview
cube is relative to the WCS by default.
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10. Managers: Managers include controls for toolpaths, solids, planes, levels, recent functions, and Art. The
Managers can be rearranged to suit your workflow.

» Toolpaths Manager: Lists the toolpath groups and machine types for the current file. Use the
Toolpaths Manager to control your operations.

Toolpaths v 1 X

k “x

= o, Machine Group-1
|:| Properties - Mill Default
=38 Toolpath Group-1
7 1-2D High Speed (2D Dynamic Mill) - [(WCS: Top] - [Tplane
-7 2 -Facing - [WCS: Top] - [Tplane: Top]
-5 3 - Contour (2D) - [WCS: Top] - [Tplane: Top]
7 4 - Contour {20) - [WCS: Tap] - [Tplane: Top]

« Solids Manager: Lists each solid in the current file along with its operation history and associated
toolpaths. Use the Solids Manager to edit solids and their operations.

Solids v 1 X
e K St RSB X @
= % [k Uprght

-4 Body

.. T 2-Facing

- T 3-Contour (2D)
- T 4-Contour (2D)
(@) Stop Op
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» Planes Manager: Shows the planes in the current file. Use the Planes Manager to adjust planes and
work offsets.

Planes v o X
+-m-Q-=cPF H-5-B-E-@

Mame G  WCS | C | T  Offset Disp... Section
o Top WCs C00T

Front

Back

Bottom

Right

Left

Isometric

» Levels Manager: Shows the levels in the current file. Use the Levels Manager to control your levels.

Levels v 1 X
+ASES-rEH-@
Mu... & Visible  MName Level Set | Entities
W 1 X Left Upright 5
2 Reference Wir... 5
3 Right Upright ]

You can learn more about Managers in "Moving and Docking Managers" on page 30.

11. Graphics window: The space in which you view, create, and modify your parts. The graphics window also

displays information about the current units (inches or millimeters), and the coordinate axes for the current
view or plane.

12



Chapter 1: Mastercam Interface Overview

Common Interface Controls

The following table shows common controls used in the Mastercam interface. The icons may vary slightly
depending on their location in Mastercam.

Icon Option Icon Option

OK and Create New @ Cancel
@ OK/Save Help
e} Apply About Mastercam

N /

Exercise 2: Exploring Mastercam's Backstage

The File drop-down in Mastercam is also known as the Backstage. Click File to open the Backstage view. The image
below shows the Info page of the Backstage with links on the left side to other pages and functions.

New
Project Manager Properties.
Open
Prcqz—:t Usethe Project Manager to specify the types of files to save in your project folder. Specifying these file types lets you keep all project files in  single place: Name
Open in Editor Manager Type Mastercam Part File

Folder Path
o - Size
< Change Recognition
Save © Compare the geometry of two versions of a part file, identify changed geometry, view the status of affected operations, and make decisions on updating the original file.
Change Descriptor Not saved yet
Recognition

Units us.

Save As

G E Track Changes
« | Manage the files that Mastercam tracks, and customize how Mastercam searches for newer versions of tracked files,
Zip2Go Track
Changes
Convert Related Dates
AutoSave Last Modified
Print
LE] Configure Mastercam to automatically save current geometry and operations at regular and specific time intervals. Created
Help AutoSave
Community L
A Repair File

Configuration A Perform routi
Repair
File

aintenance on the current file to improve performance and ensure file integrity.

Optins

The following list provides brief descriptions of some of the functions and pages located in the Backstage. Click each
page to explore the Backstage.

» Info: Presents information and properties of the current Mastercam file. The Info page gives you access to
functions that take action on the currently open file, including: Project Manager, Change Recognition, Track
Changes, AutoSave, and Repair File.

* New: Opens a new file.

» Open: Accesses the Open page where you can select a recent document or browse for a file to open. You can
pin frequently used files or folders to the Recent Documents and Recent Folders sections.

* Open in Editor: Opens a file using a file editor of your choice.
» Merge: Imports and merges entities from an existing part file into the current file.

» Save/Save As: Saves the current part file or saves the file with a new name. You can pin frequently used
folders to the Recent Folders section of the Save As page.

13
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» Save Some: Saves only entities that you select in the graphics window.

e Zip2Go: Opens the Zip2Go Wizard. The Zip2Go Wizard compresses the currently open Mastercam part and its
associated files (configuration, machine definition, post files, tool libraries, etc.) into a .Z2G, .ZIP, or .MCAM-
CONTENT file. A Zip2Go file is helpful when sharing file information with other users or Technical Support.

» Convert: Provides access to import and export functions, as well as the Migration Wizard so that you can
update older Mastercam files to the latest version.

» Print: Previews, configures, and prints the current Mastercam file.

» Help: Presents information about Mastercam and licensing. Includes links to the latest What'’s New and
Resolved Issues, tutorials, and the Help system. Visit this page to check for software updates. Access to some
of these resources requires an active Internet connection.

e Community: Links your account to Mastercam.com, Mastercam University, Mastercam Forums, Mastercam
Knowledge Base, and the Customer Feedback Program. These resources require an active internet
connection.

» Configuration: Opens the System Configuration dialog box where you set system defaults for Mastercam.

» Options: Opens the Options dialog box where you customize the Mastercam interface.

Exercise 3: Customizing the Quick Access Toolbar

The Quick Access Toolbar (QAT) is a collection of frequently used functions. The QAT is always available and can be
displayed above or below the ribbon. You can add to or remove functions from the QAT.

In this exercise you move and customize the QAT.

1. Click the Customize Quick Access Toolbar drop-down, and select Show Below the Ribbon.

OHP-O /90—

] Customize Quick Access Toolbar

File Home Wireframe
¥ Mew
@ Sph ‘-ir
1 g. phere v Saye
b Cone
Cylinder Block ~ Extrude | ¥ Open
L
= fE v Print
Simple v Save As
Toolpaths v Zip2Go
+  Undo
+ Redo

More Commands...

[ Show Below the Ribbon ]

Minimize the Ribbon

14
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The QAT displays between the ribbon and the managers.

5olids
. @ sphere ‘r 2 Revolve ﬁ ‘
A Cone B Loft
Cylinder Elock Extrude Eoolean Impres:
OT::urus f"Sweep
Simple
CCEXTEEED
Toolpaths > R ox

2. Click the drop-down again, and select More Commands.

9« j

Customize Quick Access Toolbar

v MNew

g‘ﬁcv Save
:‘—. :’:‘k% ¥ Open

Prinit

Save As

LT T

Zip2Go
Undo

<

+ Redo

More Commands...

Show Above the Ribbon

Minimize the Ribbon

The Options dialog box opens.

3. On the Quick Access Toolbar page, select View from the Choose commands from drop-down to see a list
of commands that appear in the View tab.

Cpticns

Duick Breess Toolbar
Custamize Ribbon

Cantext Meanu

Options

Choose commanics from: )
e

4. Select Redo in the right-hand pane. The command you add to the QAT will appear below this selection.

15
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E Mew
E Save
F"’ Open 4

= Print

E}' Sgve As

%
Zip2Go

5
<Separator=

"'} Undo
™ Redo

5. Select Copy from the Commands list, and then click Add.

Choose commands from:

Wiew - [ New
Commands: E Save
iﬁ = Tplane i O?En
Advanced Display r % Print
2| Advanced Toolpath Display Options E_J 5.3""3 As
Appearance - s Zip2Go
Arc midpoints Add 5 5 <5Separators
(& art ) Undo
™ Redo

< < Remove

& Back
@ sackside

b=
[il Bottom
Controllar ]

- Copy
Cplane

The command appears below the Redo command in the right-hand pane.

|__E| Mew

ﬂ Save

P Cpen *
p

&= Print

Ef: Save As

%

: Zip2Go
<Separator>

"'} Undao

f" Redo

- Copy

You can use the up and down arrows to rearrange the list.
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D Mew

E Save

FJ Open 4
= Print

Eﬁ' Sgve As

[ >
Zip2Go

5
<Separator= IZI

"'}' Undo
(¥ Redo

-
- Copy

NOTE:
The Commands list is in alphabetical order.

6. Click OK, and the Copy command shows in the QAT.

Alternatively, you can add any command in the ribbon to the QAT by right-clicking the command in the ribbon

and selecting Add to Quick Access Toolbar.

IE ﬁ) Unzoom 50% Efj" lsometric = ﬁj" Rotate
: ‘E}Unznnmm fﬂ'Right it= Cplan

Fit  Win )
- Add to Quick Access Toolbar
Customize Quick Access Toolbar...
D E r:' Show Quick Access Toolbar Above the Ribbon

Customize the Ribbon...

TDDIpatl" Minimize the Ribbon
Pe X [ To T Ly " |25 028 O - | 7 | @

7. Return the QAT to its placement above the ribbon.

Exercise 4: Using Mastercam Resources

Your Mastercam license gives you access to resources that can improve your project and advance your Mastercam
skills. Learn about using Mastercam and connect with the community to share ideas.

These resources include:

 myMastercam: Connect to the Mastercam community to share ideas, get news, seek assistance, and

download the latest versions.

» Feedback: Give feedback about your Mastercam experience.

17



Mastercam 2025 « Mastercam Basics Tutorial

» Help: Use Help to learn about Mastercam functions, gain information about parameters, and expand your
concept knowledge.

« What's New and Resolved Issues: Read the What's New to learn about the latest features in a release and
the Resolved Issues to keep up-to-date on fulfilled enhancement requests.

» Tutorials: Bolster your Mastercam skills with step-by-step tutorials that lead you through many of
Mastercam's products.

In this exercise you visit each resource and explore the options available to you.

[% NOTE:

You must have an internet connection to access myMastercam and its associated links.

Using myMastercam

1. Click myMastercam to open the login dialog box.

7
MET-5cript Command ’
Editor Finder vl A

Add-Ins E

Username:

Forgot Usermname?

Password:

Forgot Password?

2. Enter your credentials and click Login.

NOTE:
If you do not have a myMastercam account, create one at https://users.mastercam.com/signup.

18
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Chapter 1: Mastercam Interface Overview

Your myMastercam account loads. Use this feature to quickly access the CAD/CAM community, Mastercam
downloads, and your personal account.

& Mastercam

. HE| |O Mastercam.com
a

You can also use this feature to access Mastercam social media sites.

f ©in X @ w~

3. Click outside of the account dialog box to close it.

Giving Feedback in Mastercam

1. Mastercam allows you to give feedback about your experience with the software. Select Feedback in the
upper right corner of Mastercam.

stercam 2025... = O x

sndard *@l@@
¢ o P

Run  MET-5cript Command
Add-In~  Editor Finder

Add-Ins T
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The in-app feedback browser opens.

How are you feeling about your Mastercam session?

[ I consent to having my information collected and
stored by CNC Software, LLC.
View Privacy Statement

2. Follow the prompts to submit your feedback.

Using Mastercam Help

1. Mastercam Help is an excellent resource for learning about the software's functions. To access the
Mastercam Help Center, select the Help icon in the upper right corner of Mastercam.

andard =N NN

g o P

Fun  MET-5cript Command
Add-In~  Editor Finder

Add-Ins [

@ NOTE:

You can also access the Mastercam Help Center by selecting File, Help, Contents in Mastercam's
Backstage.

The Mastercam Help Center opens in your internet browser.

20



Chapter 1: Mastercam Interface Overview

Mastercam Help Center Search

Learn About Mastercam 2025

Your source for help, tutorials, and training

Getting Started Documentation Resources What's New

g B

Log in to myMastercam.com to download the latest tutorials!

Use the Mastercam Help Center to access information about CAD/CAM topics and other Mastercam
resources such as the What's New, Resolved Issues, and tutorials. Click on each of the tiles to explore your

options.
. After exploring the Mastercam Help Center, return to Mastercam.

. Context-sensitive Help is related to the location in which you click the Help button. To view an example of
context-sensitive Help, click the Help icon in the Toolpaths Manager. Use context-sensitive Help topics to
learn about the purpose and options for the dialog box in which you click Help.

Toolpaths v B ox
W hixF- EnwEol 7(@]

AR vVaAaL$ HRGERE D

@ NOTE:

If necessary, select the Toolpaths tab of the Managers.

/

JI-:Dl:'at"': Solids Planes Lewvels Recent Functions

21



Mastercam 2025 « Mastercam Basics Tutorial

Mastercam Help Center

‘ Search

Toolpaths Manager

A B

The Toolpaths Manager is a central location where you can manage all the elements of the current job. Use the

Toolpaths Manager to generate, sort, edit, regenerate, verify, backplot, and post any operation.

Toolpaths > 2 x

B D Ix - ER-Bol 7 @
axA vac$ BGE: T

B & Machine Group-1

Properties - Mil Default

Arc fit retracts - Linking arc tolerance

"7 1- 3D High Speed (Waterline) - [WCS: Top] - [Tplane: Top
=-F'7 2 - 3D High Speed (Waterline) - [WCS: Top] - [Tplane: Top
— Parameters

o T #307 - 0,2500 BALL ENDMILL - 1/4 BALL ENDMILL
Geometry

Geometry - 15 Machining
Geometry -0 Avoidance

Geometry - 3 Containment

4.’ GEometry - 1 Approximate start point

-2 Toolpath - 510.8K - Test part 1.NC - Pragram number (
Linking

" 3 - 3D High Speed (Waterline) - [WCS: Top] - [Tplane: Top
" 4 - 3D High Speed (Waterline) - [WCS: Top] - [Tplane: Top
" 5- 3D High Speed (Waterline) - [WCS: Top] - [Tplane: Top
7 & - 30 High Speed (Waterline) - [WCS: Top] - [Tplans: Top
7 7 - 3D High Speed {(Waterline) - [WCS: Top] - [Tplane: Top
7 8 - 3D High Speed {Equal Scallop) - [WCS: Top] - [Tplane: 7
" 9 - 3D High Speed {Equal Scallop) - [WCS: Top] - [Tplane: 7
Raster-Radial approximate point

" 10 - 3D High Speed (Raster) - [WCS: Top] - [Tplane: Top]
g

= 11 - 3D High Speed (Radial) - [WCS: Top] - [Tplane: Top]

> How does the Toolpaths Manager affect my part file?
> How do I use the Toolpaths Manager?
> Toolbar buttons

Learn more
* Toolpath Display
» Toolpaths Manager Right-click Menu
* Toolpaths Manager Icons

* Toolpaths Manager Shortcut Keys

4. Inthe topic, select Toolbar buttons.

> How does the Toolpaths Manager affect my part file?

> How do I use the Toolpaths Manager?

> Toolbar buttons

Learn more
e Toolpath Display

22



Chapter 1: Mastercam Interface Overview

The expanded Help menu drops down to identify and describe Mastercam interface icons. Drop-down
headings in Help topics may also describe menu options and procedures.

Toolpaths v R ox
P HhixF- ERwFol. 7 @
B B Y AaD§$ 5kl <

Selects all operat

"x  Select all operations _ L
operations withil

x

Selects all dirty (i

k Select all dirty operations :
functions on sele

Regenerate all selected

Ty Recalculates sele

When using Mastercam, context-sensitive help is an excellent resource for learning more about interface
options.

5. Scroll down to the bottom of the topic to review the links in the Learn more section. This section is located at
the bottom of each help topic with information about similar topics. Use these links to enhance your
understanding of CAD/CAM concepts.

Learn more
e Toolpath Display
e Toolpaths Manager Right-click Menu
e Toolpaths Manager Icons

e Toolpaths Manager Shortcut Keys

6. After exploring the Learn more links, return to Mastercam.

Exercise 5: Exploring the Ribbon Interface

The ribbon interface comprises multiple tabs that group together related functions and controls. Tabs are
organized in a simple-to-complex workflow from left to right.

Some tabs are contextual and only display when needed in the workflow. For instance, you must select a piece of
wireframe geometry for the Wireframe Selection contextual tab to display on the ribbon.

You can choose to show all available ribbon functions or simplify your view by showing only the most commonly
used functions.

In this exercise you personalize the ribbon tabs.

23
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1. Right-click the ribbon, and select Minimize the Ribbon.

.‘!I-ﬁ;j-omt P E—

- ap z oo
Oty Copy

Paste . . L
i@ Copy Image Customize Quick Access Taalbar.., |

Show Quick Access Toolbar Below the Ribbon
Clipboard g

Customize the Ribbon...

[ Minimize the Rihhu-n]

Toolpaths

[ s .

Only the tab names display in the interface.

2. Click any tab to display it. Click in the graphics window to hide the tab again.

Wireframe h

+ @: +/+ /f/LineParaIIeI @

|, Line Perpendicular

Point Bolt Line ) Circle
Position* Circle = Endpoints “\- Line Closest = Center Point
Points Lines

3. To redisplay the full-sized tabs, simply double-click any tab or right-click the ribbon and deselect Minimize
the Ribbon.

4. Open BLANK_PART.mcam, which was provided with this tutorial. If you see a message for switching units from
inch to metric, click OK to allow the change.

5. Select the geometry shown below.

24
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Chapter 1: Mastercam Interface Overview

The Wireframe Selection contextual tab displays. This tab contains Mastercam functions relevant to your
selected wireframe geometry.

Tools

s (3 Close Arc z O O
ties £'% Break Circles 7 D’
Fillet ~ Chamfer ] ) Dynamic Translate
endth Eptities = Entities = }'-::1 Refit 5pline = -
Modify

Press [Esc] to deselect the geometry in the graphics window.

The Wireframe Selection contextual tab disappears from the ribbon.

x x—a MNon-Associative DD @ Arc Center Points

§ Duplicates = 1”1 Endpoints
Delete % ) Hide/Unhide
Entities ‘g Undelete Entity - Elank =
Delete Display

Select the Drafting tab.

' k—{ Horizontal +/ Point F Perpendicular mTangent [ | Horizantal EWmdnw ﬁ Cross Hatch ~ %Va\ldate : Al F o ﬁ-i
. - = LS = ~l W
I Vertical AAngu\ar t:'" Baseline = Wertical e Align (' Leader E Associative :
Smart — MNote  Hole ___ al = Align Convert  Multi-Edit  Break
Dimension @ Circular ‘y Parallel m Chained + Add To Existing ¢ Parallel Table '7W|tness Line W Select Mote Legacy Mote Into Lines
Dimension ] Ordinate Annotate Regenerate Modify

Click the Ribbon mode drop-down. Ribbon mode alters the number of functions displayed on the ribbon.
» Standard: All Ribbon functions display.

« Simplified: The most commonly used Ribbon functions display. Some of the more complex Analyze
functions, Drafting functions, Curve and Line functions, Delete functions, and View options are no
longer available. Wire and Mill-Turn are not available in Simplified mode.

Standard

i ©

1 Command
In  Finder

Simplified

Add-lns

Select Simplified. The number of functions on the Drafting tab changes. Mastercam remembers your Ribbon

mode selection between sessions.

i = o—
I ! 11 Horizontal JEI ~ = 4—»1
j = Vertical ~ B
Smart — . Mote Automatic Align  Multi-Edit
Dimension + Add To Existing Mote
Dimension & Ordinate Annotate | Regenerate Modify
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11. Return Ribbon mode to Standard.

Exercise 6: Customizing the Ribbon

You can create a new ribbon tab and customize it with functions of your choice. In this exercise, you create a new
tab, add several functions, and change the tab's position on the ribbon.

1. Right-click the ribbon, and select Customize the Ribbon.

I b Horizontal = /4 Angular l=1Baseline | Horizontal E
- & 1 1 - ~—

I:S:I Circular b
smart Customize Quick Access Toolbar.., 1

- : < Point '
Dimension + e Show Quick Access Toolbar Below the Ribbon |

Dvim
[ Customize the Ribbon... ]
Toolpaths Minimize the Ribbon

= = =

The Options dialog box opens.

2. Highlight View in the Customize the Ribbon list.

Options x

Quick Access Toolbar

Customize Ribbon

Context Menu
Options Choose commands from: Customize the Ribbon:
|Command5 Mot in the Ribbon w | Main Tabs w
[ +D +Z (WCS) PA Main Tabs
& +D -Z (WCS) i [] Home
BY +X+Z (WCS) b [ Wirsframe
B +X-Z (WCS) I [ Sufaces
E? Analyze Database [ Solids
124 Analyze Number b [ Model Prep
' Back (WCS) I [ Drafting
Eﬁ Back Cplane Add > > [ Transform El
@‘ Back Tplane 4 Machine
fj.; Back WCS p— I Machine Type
E-l Bottom (WCS) > Job Setup
E‘.T Bottom Cplane = Simulator
@' Bottom Tplane > Post
& Battom WCS b Setup Sheet
== Change Line Style [ Machine Simulation

-

— Change Line Width Automatic Toolpathing
DEE Change Solid Calor

DEE Change Surface Color
DEE Change Wireframe Calor

=7 Create Lathe Quick Finish Toolpath... v | NewTab | | New Group | | Rename..
Keyboard shortcuts: Customizations:
[ ok | cance | Hep
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3. Click New Tab.

Add ==

< < Remove

New Tab (Custom) and New Group (Custom) appear in the Main Tabs list.

[ Transform
B[] A

[ Machine
B[] View

I+ Analyze
I+ Add-ns

[ Wireframe
[ Surfaces

[ Solids

[+ Model Prep
[ Drafting

& [+] Transform
o] At

[ Machine

> ER

H Mew Tab ) Mew Group

Customizations:

Rename...

Feset

4 MNew Tab (Custom)

Mew Group (Custom)

4. Select New Tab (Custom) and then click Rename.

Add ==

< < Remove

[ Transfarm
[ At

[ Machine
[

New Tab (Custom)

TR sl

Mew Tab
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5. Enter My Tab for the Display Name and click OK.

Dizplay Mame:

Rename >

by Tab

Carcel

6. Right-click New Group (Custom) and select Rename from the context menu.

7. Enter My Group in the Display Name field and click OK.

Dizplay Mame:

Rename >

by Graup

Carcel

8. Select Pan from the Commands Not in the Ribbon list, and then click Add.

NOTE:

Type the first letter of the command to jump closer to it in the Choose commands from list box.

Choose commands from:

Commands Mot in the Ribbon

Il]nr& One suface parallel steep

%) One surface pencil

Eﬂfﬂ One suface plunge

4 One suface pocket

™. One surface project

Ii?_i-. One suface project

8 One suface radial

E One suface radial

:‘_-.' One surface restmill

;‘% One suface scallop

8 One suface shallow

ﬁ|:| Only display associative geometny
k Cnly display selected toolpaths

Fi, Open Shared Folder

I3 Open User Folder

I Eicgggf Pull/Cutoff

=

Add ==

< < Remove
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Main Tabs e

Main Tabs

[
[
[
[
[
[
[
[
[
[
[
4

Home
Wireframe
Surfaces
Solids
Model Prep
Mesh

- Drrafting

- Transform
. Art

- Machine
- [+ View

My Tab (Custom)
My Group (Custom)
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The command is added to My Group (Custom).

[ Dirafting
[ Transfom
B[] At

[ Machine
B[] View

4 My Tab {Custom)

4 My Group (Custom)

$ Pan

9. Select Zoom Target from the Commands Not in the Ribbon list, and then click Add.

VBScript...

* Werify Selection

'ﬁ. Wiew From Ertity

"=I"| View From entity nomal

f_]j' View From Solid Face

Wi WCS = Cplane

W WCS = Tplane

<§> Wireframe Coons Toolpath...
B X +Z (WCS)

EY -X-Z wes)

g Z-Spiral W

The command is added to My Group (Custom).

10. Select My Tab (Custom), and use the up arrow button to position the tab below the Home tab.

Customize the Ribbon:
Main Tabs w

Main Tabs

> [w] Home

Wireframe
Surfaces

Solids

Model Prep

Mesh

Drafting B
Transfom

At

Machine

View

My Tab (Custom)

4 My Group {Custom)

'f' Pan

rﬂ'} Zoom Target

—

[ - I~ B~ B~ B~ I~ IR v K v~ B v I ]

11. Click OK to close the Options dialog box.
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12. Choose My Tab to view your customized tab with the Pan and Zoom Target commands.

File Home My Tab Wireframe

r===n
1 1

+ @
1 1

CEER |

Pan Zoom
Target

by Group

13. Onyour own, return to the Options dialog box to add more commands to your tab, or rearrange the order of
the ribbon tabs.

Exercise 7: Moving and Docking Managers

Mastercam has several movable, dockable managers that provide flexible access to frequently used functions
including toolpaths, solids, planes, levels, and recent functions.

You can toggle the display of the managers, as well as move one or more managers to a new location. Docking
behavior follows standard Windows controls. Dock a manager to a fixed location on the interface, float it anywhere
on the workspace, or even move it to another monitor. Mastercam remembers the settings even after you close the
application.

In this exercise, you customize the Mastercam interface by hiding, displaying, and moving the managers.

1. Select File, New to start with a new part file. Select Don't Save if you are prompted to save changes to the
current Mastercam part file.

2. Click the Toolpaths tab to bring the Toolpaths Manager to the front.

Toolpaths | Salids  Levels Recent Functions Planes

3. Hide the Toolpaths Manager by clicking the Close button in its upper right corner.

Toolpaths - @

4. Re-display the Toolpaths Manager by choosing Toolpaths in the Managers group on the View tab.
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:a |E| Levels |E| Groups

t:| Solids  [&] Multi-Threading |[t:] Recent Functions
Advanced
Display ~ IE Planes IE Art

Toolpaths M Managers

@ NOTE:

The Recent Functions panel is not a manager, but it resides in the same location as the Managers
for ease of use. Recently used functions are recorded and can be repeated by selecting them from
the Recent Functions list.

Recent Functions v X
¥ Display the What's New Dialog

|E| Show or hide the recently used functions manager

= Create Note

[ Create rectangle

Gj Create Circle Center Point

|E| Show or hide the art manager

5 Teggle 20/30 Point selection

' Teggle Shading Translucency On and Off

£} Edit configuration

D Create a new document

e

Toolpaths Solids  Planes Levels[RecentFuncticlns
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5. Select the title bar of the Toolpaths Manager, and drag the panel of managers into the graphics window.

File Home Wireframe Surfaces Solids Model Prep N
. T . .Y
E Unzoom 509 ff) Isometric v [§] Rotate 1
ﬁUnzoom 305: B f]_f Front ~ §ﬁ= Cplane »
Fit  Window Top . Sectior
© & Named ~ View ~
Zoom Graphics View

AN

Toolpaths v X
e /

Toolpaths | Solids Planes Levels Recent Functions

The managers are now floating in the graphics window.

6. Click and drag the managers again. Drop them onto the blue docking icon on the right side of the interface.

NOTE:
Docking icons snap the managers into alignment with the graphics interface. Hover the stack of

managers over a docking icon to see a preview of the new location.
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Toolpaths
Py Xy | Th Tx Ty -
GXx A var

Toolpaths | Solids Planes Levels Recent Fundions

All of the managers are now docked in the new location.

k- Show Axes ~ y T&— . B " hew >
E '* v ]H Save Bookmark

- Q‘; Show Gnomons ¥
Show  Snap Rotation = On/Off »
wd Restore Bookmark

T Show Toal ~ Grid to Grid = Position
Display ] Grid & Controller Viewsheets 1F}
Toolpaths > 3 ox

B Ik F-ER-Boh 7@
BER vaC £ 5G| DY

0.9747 in
Toolpaths | Solids Planes Levels Recent Functions
o @

0000 ~ 3D CPLANE:Top ~ TPLANE: Top ~ WCS:Top ~
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7. Click the Planes tab, and drag and drop it anywhere on the workspace (except on a docking icon).

0.0

[ 0.6509in |
| Inch | Toolpaths Solids | Planes | Levels Recent Functions
000000 ~ 2D CPLAME: TOP = TPLAME: TOP -~ WCS TOP - ) A

8. Resize the Planes Manager by clicking and dragging any of its edges.

(2,
k]
Planes v X
+ - m- QA =cB 05 050
Mame G |WCS5 C T Offset Disp... Sectio
- | wv.lc/t! | | |
Front G
Back
Bottom
Right
Left
Isometric
Isometric re..,
Trimetric
4 2
Work offset: Manual -1
®) Automatic
Calor: -
0.0
0.0
0.0
Comment:

9. Double-click the Planes Manager's title bar to redock it on top of the stack of managers.

10. Click the title bar of the stack of managers, and drag it to the left side of the graphics window, where it was
docked at the beginning of this exercise.

If you work with multiple monitors, you can position the managers onto the monitor that is not running
Mastercam to free the entire graphics window for drawing.

34



Chapter 1: Mastercam Interface Overview

Exercise 8: Setting Entity Attributes in the Current File

Entity attributes determine point and line styles, as well as the colors associated with entity types you create in
Mastercam. You can change the attributes of selected entities in the graphics window two ways:

1. Use the controls on the Home tab.

File Home Wireframe Surfaces Solids Model Prep

[*]
o Cut
."Dd N * v |—— v |—— |3 z

Past EE'CUFI}.-‘
aste . . A . LEE R = |-
0l Copy Image E l B @ W = {1

TEE

Clipboard Attributes M

2. Use the right-click mini-toolbar.

v E b d b

. . - H1 . W
- =

*
@ =58 Z oo - | 2 |1: Left Upr - | [

r__i] Zoom Window
,@ Unzoom 80%
@ Dynamic Rotation
H Fit

@ Top (wcs)
& Front (WCS)

When nothing is selected in the graphics window, you can also set entity attributes for the current file using these
controls. To set entity attributes that persist between sessions, use the Colors and CAD pages of the System
Configuration dialog box.

In this exercise, you use the attribute controls located on the mini-toolbar.
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1. Select File, New to start with a new part file. If prompted to save BLANK_PART.mcam, choose Don't Save.

2. Right-click the graphics window to open the mini-toolbar and context menu.

E . M- R I R I
S =B 2o = =T
[O] window

}5} Unzoom 0%
@ Dynamic Rotation

Eﬂ' Top
i]j' Front
G Right
ﬁ]j' Isometric
GView r
ﬂ Quick Cplane

2 Delete Entities
- .
\ Analyze Distance

‘\? Analyze Entity

3. Select Toggle Attributes Panel on the mini-toolbar.

P r -ET‘TETJT

@'%FHJE*EBD Z |00 .| - _

The mini-toolbar now displays independent of the right-click menu. You can size and position the mini-
toolbar anywhere in the graphics window or anywhere on your desktop.

# vf———— 3 B B4R = 2 00 | # | [*

4. With nothing selected in the graphics window, click the Line Style drop-down, and choose the style shown
below.

Any new geometry you create uses the line style you select.
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5. Select the Line Width shown below.

New geometry you create uses the line width you select.

6. Click the Wireframe Color drop-down, and select green as shown below.

7‘& - - viwlv:udv

@'V = D"._'I E-rE an Z |00 Default Colors

N N
ETEEEN

EEEN
HEN HEN
Standard Colors

smn  Wore Colors...

7. On the Wireframe tab, choose Rectangle.

,j -|—-+_'|_ Arc 3 Points ] I:l A @ E E
| Arc Tangent
I . .

= )
agint '\ Circle Edge Point = pgapual = - Letters Box  Boundary P

Arcs Splines Shapes

The Rectangle function panel opens.
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8. Click in the graphics window and draw two rectangles of any size. Follow the prompts in the graphics window.

Ar—H

9. Click OK.

Rectangle 1 X

Basic

Paints ~

12

Your rectangle wireframe geometry is created.

10. Hold down your left mouse button and drag to draw a window around one rectangle in the graphics window.

. A 4 N

A

A

BN
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Mastercam selects the rectangle.

- i'f - e -y = H-I.F -
11. Click the Wireframe Color drop-down and select purple.

-3D iv‘vmvﬂv@vi‘grud
Default Colors

Only the rectangle you selected changes to purple.

» 4. 4 4y

The default wireframe color does not change on the mini-toolbar. Any new wireframe geometry you create
still uses the default color, which is green.

7|.¢--\.—N—N--—-3|::|.‘vmv
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12. With nothing selected in the graphics window, set the Line Style to the option shown below. This resets it to
default.

* ._-I:g[) iv

14. Set the Wireframe Color to the default blue shown below.

Rl RV R ;e -
Default Colors

ndard Colors

15. Select Toggle Attributes Panel to return the mini-toolbar to the right-click menu.

Z |00 - M @

16. Click File, Save. Name your file ATTRIBUTES.mcam, and save it in the same location as the other tutorial files.
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Exercise 9: Understanding the Selection Bar and AutoCursor

The Selection Bar combines tools used to select entities in the graphics window and AutoCursor controls. The
Selection Bar is located across the top of the graphics window and has two modes, Standard Selection and Solid
Selection, that are activated based on the function you are using.

i AutoCursor + 7 * L E RS RE LTl
AutoCursor controls detect and snap to points as you move the cursor over geometry in the graphics window.

AutoCursor becomes active whenever Mastercam prompts you to select a position in the graphics window.

In this exercise, you locate points and lines using AutoCursor and Fast Point mode. Use Fast Point Mode when
AutoCursor is active to input X, Y, Z coordinates to set an endpoint.

1. If necessary open the file, ATTRIBUTES.mcam, that you saved from the previous lesson.

. s e e —

o ) § ) §

< 131 1

< L1 11
A—t, A ——A,

2. Onthe Wireframe tab, select Line Endpoints.

File Home My Tab Wireframe Surfaces
+ .~ Line Parallel
I.L + _,I
i Line Perpendicular
Paoint Bolt Line ) L
Position= Circle \ Endpoints Line Closest - Cent

Points Lines

The Line Endpoints function panel opens, and Mastercam prompts you to specify the first endpoint.

@ NOTE:

If you are using multiple monitors, the prompt may appear on a different monitor.
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3. Click the AutoCursor drop-down and select Midpoint.

i AutoCursor| = | x¥2 13 " 5N

i AutoCursor

_+. Crigin

(+) Arc Center
Face Center
\‘\+ Endpoint
“# Intersection
_# Midpaint )
" Midpaint 2 Paints

4. Click anywhere on the top line of one of your rectangles and drag up to draw a line.

e N -] - J! -
=
=< <
= <
- . Ar 4

Mastercam uses the midpoint of the entity that you selected as the first endpoint.

5. Click to set the second endpoint.

kb
A A

42



Chapter 1: Mastercam Interface Overview

6. Select OKin the Line Endpoints function panel.

.

7. Press [F9] to show the coordinate axes in the graphics window.

8. On the Wireframe tab, select Circle Center Point.

O,

Circle
Center Point

Wireframe

Arc 3 Points

/"' A7 Line Parallel

T Jl Line Perpendicula
Line
‘ndpoints ’\ - Line Closest =

Arc Tangent

Circle Edge Point =~

Lines Arcs

The Circle Center Point function panel opens, and Mastercam prompts you to enter the center point.
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9. Select AutoCursor Fast Point on the Selection Bar to display the Fast Point field. You can enter numbers,
formulas, or X,Y,Z coordinates.

L e L r UITIE CUye  Cuygcs JLE CIILILIES ™ FIELEY ™

Curves

ER}ﬂutOCursnr G
@ NOTE:

You can also press the spacebar to display Fast Point mode.

10. Type 0,0,0 to enter the coordinate location of the circle’s center point, and then press [Enter].

E D

Enter the center point

Circle Center Point 7 x

Basic

Entity ~
Method: ® Manual

11. Drag and click to set the radius of the circle. The center pointis 0,0,0.
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12. Choose OK in the Circle Center Point function panel.

Circle Center Point 7 x

Basic

Entity ~

13. If the entities are outside of the graphics window, right-click and choose Fit.
14. Press [F9] again to hide the coordinate axes.

15. Save your file.

Exercise 10: Using Quick Masks

Mastercam’s Quick Masks allow you to select all entities of a specific type or to select only entities of a specific type.
Most Quick Mask controls are divided in half. Clicking the left or right side of the control toggles between all/only
selection modes. You can select multiple Quick Masks. Hover over each control to view the tooltip describing its

function.

In this exercise, you select entities using several Quick Mask functions.

1. If necessary click File, Open and open ATTRIBUTES.mcam, which you saved in the previous lesson.

2. Click Clear all masking.

S

®
~

3. Click Select all line entities.

+

N\

*
o
X
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Mastercam selects the rectangles and line that you drew in the previous exercise.

@ NOTE:

In Mastercam, a rectangle is a set of four lines.

1 1
| r -_—
[ = I
| P -
'.l -I I /7-\—\__\__‘.“
]
i I 1 .
- i.f — I - o = #F -— /

4. Click Clear selection to deselect the line entities.

s

\

®

5. Click Select only arc entities.

4
QO

1\

&
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6. Click and drag to window select all entities in the graphics window.

L
=
Mastercam selects only the arc.

If there had been arcs outside of the selection window, Mastercam would not have selected them. The Select
only side of quick mask buttons only selects geometry inside of the selection window.
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7. Click Clear selection.

S

8. Click Select all entities by color.

\E]

The Select All dialog box opens.

9. Select the blue color checkbox, and then click OK.

Select All >

All Entihes
Transfaorm Fezult
Tranzform Group O

Graup Manager

Ertities
Colar
Level
Width
Style
Paint

ODooodrd

Miscellaneous

@ NOTE:

Notice that Select only arc entities and Select only wireframe entities remain selected from the
previous steps and affect the outcome.
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Mastercam selects only the circle because it is the only blue arc entity.

q .'
> < o
o - -
7 ~
g . / \
N \
\ ;I
\ .
j
A
M, _ - <

10. Select Clear all masking.

11. Save your file.

Exercise 11: Editing Geometry from the Top-Level

If no other function is active, you can edit wireframe geometry without interacting with a dialog box. In Mastercam,

we call this top-level editing. In this exercise, you use this feature to edit lines and arcs in ATTRIBUTES.mcam.

Editing with line controls

1. If necessary click File, Open and open ATTRIBUTES.mcam, which you saved in the previous lesson.

2. Double-click a line. Since no other function is active, the line highlights with a combination of spheres and a
button.
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e
- -
P —,
- -~
=
® - >~
=
o—r—, 11 1 /
TR /

3. Toggle the button from Move to Copy.

i
”~
@
C 3
hd
LY ) @ty

4. Click and drag the blue sphere to create an offset parallel line.

50



Chapter 1: Mastercam Interface Overview

5. Click and drag either of the endpoint spheres on the newly-created line to shorten, lengthen, or change the
angle of the line.

6. Hover over the green or red sphere to display its arrow.

7. Click the arrow to activate the ruler control. Type an exact value and press [Enter] twice to precisely change
the length of the line.

8. Press [Esc] to exit the function.

Editing with arc controls

1. Double-click the circle. Since no other function is active, it highlights with a combination of arrows and
buttons.
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2. Click and drag the origin sphere to move the center point of the circle.
3. Click and drag the green and the red arrows to change the sweep angle of the arc.
Hover over the red arrow and notice that Mastercam displays the absolute value of the sweep angle. In this

example, the absolute value is 195.00 degrees.

5. Toggle the ABS/REL button to change the display so that it shows the angle's relative value. This example

now shows the relative value is 143.02 degrees.
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6. Click and drag the blue arrow to change the radius of the arc. As with the line controls, you can type in an
exact value.

7. Click the Flip button to invert the arc and display its complement.

You cannot edit multiple entities with top-level editing. To do that, use the Analyze function. To display the Analyze
dialog box from the top-level, press the [End] key. You can continue to use the new graphic controls as well as
change entity attributes such as level, color, and line style. Press the [End] key again when you are finished. (The
section, "Analyzing Your Part" on page 97, later in this tutorial has more information about the Analyze function.)

8. Press [Esc] to exit the top-level editing function and save your part.
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Exercise 12: Exploring the Status Bar

The Status Bar across the bottom of the Mastercam workspace displays the XYZ coordinates of the cursor in the
workspace. It also provides quick access to the 2D/3D switch and lets you modify the Cplane, Tplane, WCS, and Z
Depth of geometry and toolpaths in the graphics window. The right side of the Status Bar contains wireframe,

shading, and translucency controls.

In this exercise, you use the wireframe, shading, and translucency controls to change the appearance of a part.

1. Open BRACE.mcam, which was provided with the tutorial. If you see a message for switching units from inch

to metric, click OK to allow the change.

2. Choose Wireframe on the Status Bar.

| 47.787 mm |
| Metric |

TPLAME: Top = WCS: Top - J )

3. Choose No Hidden on the Status Bar.

| 47.787 mm |
\‘I Metric |

TPLANE: Top ~ WC5 Top - 4 ’
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The part displays only the wireframe that is visible in the current view. No hidden wireframe is visible.

4. Choose Outline Shaded and Translucency on the Status Bar.

| 87.975 mm |
| Metric |

= TPLAME: TOP - WCS: TOP - O @
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The part displays as a translucent solid.

You can also alter how a part displays using the Appearance options located on the View tab.

ﬂ @ O J ' Translucency =¢' |E| Toolpaths
@ Backside = [t solids

Section  |Wireframe Outline Material Advanced
View - Shaded = @ Mesh Facet Edges Display = |E| Planes
Appearance Y Toolpaths &~

5. Close Mastercam without saving your changes or leave the part open for the next exercise.

You have now completed this chapter of the Mastercam Basics Tutorial. In the next chapter, you learn more about
Mastercam configuration files.
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Working with Configuration Files

The System Configuration dialog box defines and manages the configuration files that store Mastercam’s settings.
You can change your system configuration or create a new configuration at any time. It is easy to switch from one
environment to another because each configuration is saved to a separate file.

In this chapter, you change options in the System Configuration dialog box to see the different kinds of settings
that are stored within one configuration file.

Goals

» Create a configuration file.

e Change system colors and CAD styles.

Modify the size and opacity of on-screen controls.

« Set up AutoSave and Backup.

Exercise 1: Creating a Configuration File
In this exercise, you create a configuration file (.config).

1. Press [Ctrl + N] to create a new file.
If prompted to save your work from the last chapter, select Don't Save.

2. Select File, Configuration.

Help AutoSave
Community
Configuration RA"‘f‘
Repair
File
Dptions
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The System Configuration dialog box opens.

System Cenfiguration

----- Analyze

..... CAD

o Chaining

[ Colors

----- Communications

----- Converters

----- Default Machines
Dimensions and Motes
Files Number of places after decimal for analyze MN.123 w

[#--- On-Screen Controls

----- Planes

""" Post Dialog Defaults Analyze Measurement Options

----- Printing

----- Reports Units for Analyze Measurements Milimeters w

[ Sereen

----- Selection
Ry Precision for Analyze Measurements L1 e
----- Shading

[ Sinlwzlaﬁon Display full value tooltip
..... Solids

----- Spin Controls

----- Start / Exit

----- Tolerances

[#--- Toolpath Manager
----- Toolpaths

"1 Ef I:h Current: v o 0‘

3. Click Save As in the lower left corner.

----- Shading

[ Simulation

----- Solids

----- Spin Controls

----- Start / Exit

----- Tolerances

[ Toolpath Manager
----- Toolpaths

" Eff EE Current:

The Save As dialog box opens.

4. Enter Tutorialconfig for the File name.

File name: | Tutorialconfig|

Save as type: | Mastercarmn Configuration File (*.config)

5. Click Save.

Mastercam creates a new .config file. You can create multiple .config files using the same method.

-]
F.,x'f EE Current: | C:\Usersh YOneDrive - C...\Tutorialconfig. config <Metric=
g g

In the following exercises, you save system settings to this configuration file.

Exercise 2: Changing System Colors

In this exercise, you change some default colors to customize Mastercam's interface and geometry colors.
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1.

System Cenfiguration

Advanced Toolpath Display
Tools and holders
Simulation Display
Geometry Display
Communications

Converters

Select Background (gradient start) from the list.

Calar:

|

Auta-highlight
B ackground [gradient start]

B ackground gradient end
Calculable field
Chain

Chapter 2: Working with Configuration Files

In the System Configuration dialog box, select the Colors page.

Background (gradient start) is assigned to color 111.

3. Select white from the color options on the right side of the dialog box.

FI

Auto-highlight
Avoidance geometr

Color:

B ackaround [gradient start)

B ackground gradient end
Calculable field

Chain

Chain highlight

Chain preview material crosshatch

The start of the gradient background is now white.

Customize...

EEENEEE EENCOEe

O o O o o

E N
=] |
[
[
[
L
L
M
ML=
IS
IS
IS
HEN
HEN
HEN
HEN

4. Deselect Use gradient background to remove the gradient from the background.

[ [ | Use gradient background ]

Dlirection: Harizartal
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NOTE:

The drop-down list next to Direction allows you to set gradient direction when Use Gradient

background is selected.

Ilze gradient background

Direction: Harizontal

Wertical
Diagonal

While you can change the defaults of many Mast
page customizes the colors for most types of Ma

5.
Geometry Display page.

Systemn Configuration

Analyze
CAD
- Chaining
.
: Advanced Toolpath Displar
Tools and holders
Simulation Display

Geometry Display

Cornrmunications

Converters

6. Select Wireframe geometry from the list.

ercam interface colors on the Colors page, the Geometry Display

stercam geometry.

If necessary, expand the Colors node on the left-side of the System Configuration dialog box, and select the

System Configuration
----- Analyze s
-----
[ Chaining
& Colors Mesh . A~
------ Advanced Toolpath Displar mz::: Esgés'de
------ Tools and holders Remainder
------ Simulation Display Result
------ Geometry Display gnl@g edge
I olids
Eg:ﬁ:ﬁlﬁ:mns Surface backside
Surface edge
----- Default Machines Fare fron
[+ Dimensions and Motes Wireframe geometry W

Wireframe geometry is assigned to color 1.
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7. Type 163 for the Color value, and press [Enter].

Solid zelected edge ~
Solid selected face loop

Solids

Surface back side

Surface edge

Wireframe geometry you create now uses this color.

8. Click Apply to save the settings on this page and leave the System Configuration dialog box open.

ollo[o]]e

9. Choose Yes to save all current settings to the Tutorialconfig.config file.

Systern Configuration

ChUsers’ A0neDrive - CHC Software,

o Save all current settings to configuration file?
LLCyDesktopiTutarialconfig.config

If you choose 'No’, these settings will apply for this session
only.

@

Choosing Yes preserves your changes. They are in effect every time you open Mastercam. If you choose No,
the changes are in effect only until you close Mastercam.

Exercise 3: Changing CAD Settings

In this exercise, you make changes to the CAD page. The CAD page specifies design defaults, such as default line
and spline attributes.

1. Select the CAD page.

Systemn Configuration

- Analyze -~
..... cab
: Chaining
b Chain Similar
Colors
----- Advanced Toolpath Dizpla
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2. Inthe Default attributes section, select the Line style shown below.

Default attributes

Line style Line width Paint ztyle

—— | —— 3 at

b it i
Wm entities [glawer]

Wireframe geometry you create now uses this line style.

3. Select the Line width shown below.

Default attnbutes

Line style Line width Puaint gtyle
i L -+ L
»Farm 3
Presview >
®on )0

[ ] Check for duplicate entities [zlower)
Wireframe geometry you create now uses this line width.
4. Click OK in the System Configuration dialog box.

5. Click Yes to save all current settings to the Tutorialconfig.config file.

Systern Configuration

Save all current settings to configuration file?
ChlUsersy,
[Drocuments\My Mastercam
2023 \Mastercam\ CONFIG\Tutorialconfig.config

If you choose 'No’, these settings will apply for this session
only.

Yes Ma
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6. On the Wireframe tab, select Rectangle.

Model Prep Mesh Drafting Transform Art Machine iew

) e ~ |BIA D B |

e = ) Spline Rectangle |Create Bounding Silhouette
agint ' Circle Edge Point *  pjapual - = Letters Box Boundary P
Arcs Splines Shapes

The Rectangle function panel opens.

7. Follow the prompts to create a rectangle, and then click OK in the Rectangle function panel.

Y Y Y
w w w
The line style and width of the geometry matches the selections in the CAD page, as well as the geometry
color set in the Colors page.

Exercise 4: Changing the Size and Opacity of On-screen Controls

In this exercise, you set the size of the on-screen gnomons and text and change the opacity of the Selection Bar
and Quick Mask buttons.

1. Click File, Configuration to open the System Configuration dialog box.
2. Select the Screen page.

----- Post Dialog Defaults
----- Printing

----- Reports

-

----- electon

----- Shading

[ Simulation

----- Solids
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3. Move the slider for the Cube/gnomon size to 3.
Gview controls

Rotation button increment (degrees) 15.0

Cube text size:
Small ' Large

Cubefgnomon size:

Small ' Large
Cube opacity:
0% ' 100%:

This option adjusts the size of the Gview cube. Watch as the size changes with the slider movement, and
choose the size setting that you like. Below, the image on the left shows the slider set to 3 and the image on
the right shows the slider set to 7.

Z
G

P D, Ton i g
IQ’”’ :

@ (= — Xisometric Q) (== =—=b 150

4. Click OK to close the System Configuration dialog box, and select Yes to save your settings.

5. Right-click the GView cube and click Show Cube to toggle its display. Use the arrows on the left side and the
bottom of the GView cube to pan the display left or right.

6. Reopen the System Configuration dialog box.
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7. On the Screen page, move the Overlay controls opacity slider from left to right.

Graphics window display controls

Corner gnomons size:

Small ' Large
Display text size:
Small ' Large
Owverlay controls opacity:
0% ' 100 %
Toolpaths

[ ]Level name

Unit/scale

This option adjusts the opacity of the Selection Bar and Quick Masks. Watch as the opacity changes with the

slider movement, and choose an opacity setting you like. The first image below shows the slider set to 50%
opacity and the second image shows the slider set to 100% opacity.

I AutoCursor ~ 35 B -

- @53

8. Click Apply to save the settings on this page.

9. Select Yes to save the settings to the configuration file.

olloo])e

Exercise 5: Setting up AutoSave and Backup

When you work on a part, Mastercam can save your changes automatically at intervals that you specify. You can
also save versions of your files as backups. In this exercise, you set up these functions.

1. Expand the Files category, and select the AutoSave / Backup page.

b Drefault Machines
Dimenzions and Motes
o Files
- | AutoSave / Backup |
[ On-Screen Controls
- Post Dialog Defaults
- Frinting
- Reports

2. Inthe AutoSave / Backup page, do the following:

« Select AutoSave to activate the AutoSave options.

* Enter 10 for Interval (in minutes).
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» Select Mastercam Backup Files to activate the backup options.

Ao ave
Save uzing active file name Interval [in minukes]: I: 10 :I

] Ovenwrite existing file name

[] Disable dirty solids wamings
Prompt before zaving file

[ 5ave after every operation

File name:

C:hU zersemghDocumentzikdy b aztercam

Maztercam Backup FiIED

|Jze backup directory as defined in Files

Mastercam will save your work automatically every ten minutes and keep the ten most recent
versions of your file.

3. Select the Files page to view the location of your backup files.

4. Choose Backup files (Mastercam format) in the Data paths list. The path displays in the Selected item box
as shown below.

D ata paths File L
b M aztercam Folder ~ Def;
Shared Maztercam Folder Diefe
bl aztercam Parts [mcam, emcam) Latt
ALCIS Kemel SAT files [zat, zah) Latk
Alibre Design Files [ad_prt, ad_zmp) Latk
ASCI files [k, cav, doc) Latk
AutaCAD Files [dwg, d=f, dwf] Latk
Autadesk [nventor Drawing Files [idw] Latk
Autadesk [nventaor files [ipt, 1am Latk
Backup filez [Mastercam format] Mill |
Batch files [beh) kil |
Cadkey CADL files [zdl b ill 1

Selected iterm; Selec

C:hUzershemahDocumentz\ by M astercam 2022'&Mastercam'&F‘arts'\| Eﬁ All Ce

5. At the bottom of the System Configuration dialog box, select mcamxm.config <Millimeter> from the
Current drop-down to enable millimeter configuration for the remainder of this tutorial.

Current:  |c:lusersl] : Hone...\mcamxm. config <Millimeter = &

6. Click OK.

@ NOTE:

If you would like to learn more about the individual settings on any System Configuration page, click the
Help button located in the lower right-hand corner of the dialog box.

ollollofe]
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Chapter 2: Working with Configuration Files

You have now completed this chapter of the Mastercam Basics Tutorial. In the next chapter, you learn how to
customize the Mastercam workspace.
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Chapter 3

Customizing Mastercam

In this chapter, you learn how to customize your Mastercam workspace, including tab and interface options, the
graphics window context menu, and keyboard shortcuts. Your settings apply each time you open Mastercam and
are not specific to a configuration file.

Goals

e Customize the graphics window context menu.
» Map Mastercam functions to keyboard shortcuts.

» Set display options for tabs and interface colors.

Exercise 1: Customizing the Graphics Window Context Menu

In this exercise, you customize the graphics window context menu that displays when you right-click in the graphics
window. Customizing this menu allows you quick access to your commonly used functions.

1. Select File, Options.
The Options dialog box opens.

2. Select the Context Menu page.

Options x

Quick Access Toolbar Choose commands from: Context Menu:

Customize Ribbon Mil toolpaths v Import

& .0 ) ) )
Context Men ‘3" 3+2 Automatic Roughing - = v ngl‘imouls:al_buﬂon menu
£ Advanced Dl Zoom Window

Options [E] Area Mil N Unzoom 80%

¥ Area Roughing % Dynamic Rotation
£2 fude Mill iofa gl Fit

Categories of functions are displayed on the left side of the dialog box, while the right side contains the
functions currently in the context menu.
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3. Select the last item in the Context Menu list, and click Insert Separator to place a line of separation after the
item.

- | SEPARATOR
i3 Delete Ertities

- | SEPARATOR
= \E Analyze Distance

N

Right-click in Cortext Menu list for more options.

[ Insert Separator ] Create Submenu

Customizations: Reset

@ NOTE:

You can also right-click the last item in the Context Menu list, and select Insert Separator from the
menu to place a line of separation after the item.

A separator line appears after the last item.

)( Delete Entities
| SEPARATOR
"@ Analyze Distance...

\\? i = Friti PI‘CIIZIEI'tiES...
i |((SEPARATOR

4. Select File Tab from the Choose commands from drop-down list.

Choose commands from:
File Tab -

Commands Mot in the Ribbon
All Commands

Selection

Add-ins

At

Mill toolpaths

Lathe Tuming toolpaths
Lathe Miling toolpaths
Lathe Routing toolpaths
Mill-Tum Tuming toolpaths
Mill- Tum Milling toolpaths
Wirepaths

Rowuter toolpaths

All Tabs
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5. Select the Save As function in the Category list and SEPARATOR in the Context Menu list.
! Frmi...

%3 Pun Add-In

e Import Folder...

3, Export Folder...

F'I Open User Folder
h': Open Shared Folder
_; Migration Wizard. ..

[E Merge

1 A tosave Parameters

Add ==

< < Remove

6. Click Add to add the Save As function after the separator.

= w» Right mouse button menu
Zoom Window

----- Unzoom 807%

----- 1) Dynamic Rotation

Fit

----- | SEPARATOR

- Top (WCS)

) Front (WCS)

- Right (WC5)

~£f) lsometric (WCS)
- w GView

----- | SEPARATOR

----- X Delete Entities

----- | SEPARATOR

----- \? Analyze Distance...
----- \3 Analyze Entity Properties...
----- | SEPARATOR

~fell Save As...

7. Click OK to save these changes to the right-click menu.
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8. Right-click in the graphics window to see the updated context menu.

Zoom Window
Unzoom 808
Dynamic Rotation
Fit

Top (WCS)

Fromt [(WCS)
Right [WCS)

Ga%9a HowD

Isometric (WCS)
GView 4

Cuick Cplane

"2

>

Delete Entities

‘@ Analyze Distance...
\? Analyze Entity Properties...

E{ Save As..

Save As has been added to the bottom of the menu.

Exercise 2: Mapping Functions to Keyboard Shortcuts
In this exercise, you map a Mastercam function to a shortcut key.

1. Select File, Options.
The Options dialog box opens.
2. On the Quick Access Toolbar page, select Customize next to Keyboard shortcuts.

&T Bottom Cplane
Ii'}' Bottom Tplane
& Bottom WCS v

[ ] 5how Quick Access Toolbar below the Ribbon

Keyboard shortcuts:

The Customize Keyboard dialog box opens.
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3. Select Home from the Categories list.

Categaries:

File Tab
Home
Wireframe
Surfaces
Solids
Model Prep
Mesh
Nraftinn

The Commands list populates with functions from the Home tab.

/é'

[+]

4. Select Statistics from the Commands list.

Categaries:

File Tab
Home
Wireframe
Surfaces
Solids
Model Prep
Mesh
Nraftinn

§

[+]

Commands:

=D +Z [(WC3)

+D -Z (WC5)

+X +Z [WCS)

+X -Z (WCS)

2D Area
sDAnnotationFinder
Activate Solid Selection
Add-In Path Ointinns

Commands:

Solid Color

Sort Circles
Standard Selection
Standard selection
Statistics

Surface Area
Surface Color
Swient?R

Chapter 3: Customizing Mastercam

=

[+]

L]
~]

Notice that the Current Keys list is blank. This is because there are no shortcut keys assigned to this function.

5. Click in the Press new shortcut key field, and press [Ctrl+Shift+H] to create a new shortcut key.

Drafting Surface Color
Transform W Swept2R W
Curment Keps: Prezs new shaortcut ke

6. Select Assign to map this shortcut key to the Statistics function.

=

|i:tr|+5hift+H

Azzigned to;
[Unaszzigned]

7. Select Close to exit the Customize Keyboard dialog box, and then OK to close the Options dialog box.
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8. In the graphics window, press [Ctrl+Shift+H] to access the Statistics function.

Statistics >

4 Lines

The Statistics dialog box displays a summary of the entities in the current file, including total number of
visible entities by type, and the number of operations and tools. In this example, Statistics reports four lines
because of the rectangle created in the previous lesson.

9. Click OK to close the dialog box.

Exercise 3: Setting Mastercam Display Options
In this exercise, you set some of Mastercam’s display options.
1. Select File, Options.

The Options dialog box opens.

2. Select the Options page.

Opticns

Ouick Access Toolbar
Customize Ribbon
Context Menu

Manager Panels

[ ]Large icons

3. Select Large icons.

Manager Panels

Large icons

Tab position {restart required):

(i Top
() Bottom
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4. Set Theme to Colorful and Accent color to Green.

Interface
Theme: Colorful w
Accent color: . Green >

Enable ribbon access keys

5. Click OK to close Options. Mastercam uses the larger icons and green theme.

X owde

jector / & \\\

e Bous ilhouette Turn Curve  Curve All Curve Slice
tters  Box  Boundary Profile Groove [I] Dot 1y OmeEdge Edges byPlanc

N N\
4

X

L Join Entities

Curves

¥
[%
0]
X
>}
2
%
]
»
5y
o
b
s
®
o ")
v

s

i

- 47.787 mm

Taolpaths | Solids Planes Levels Recent Functions B> % }—{MM

6. Click File, Options, and return the options to the original settings.

7. Close Mastercam without saving your changes or leave the file open for the next exercise.

You have now completed this chapter of the Mastercam Basics Tutorial. In the next chapter, you learn more about
working with files.
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Chapter 4

Working with Files

Mastercam not only saves and loads its own file types (.mcx-*, .mcam), but also many common file formats, including
the following:

» SOLIDWORKS (.sldprt, .sldasm, .slddrw)

» AutoCAD (.dwg, .dxf, .dwf)

» ProE/Creo (.prt, .asm)
For the full list of available formats, refer to the Mastercam website (mastercam.com/support/technical-

support/translators/). Load and save native Mastercam files by selecting Open, Save, Save As, or Save Some from
the Backstage menu or from the QAT.

nfo

-— Project Manager
Project Use the Project Manager to specify the types of files to save |
Manager

% Change Recognition

Compare the geomnetry of two versions of a part file, identify

Change
Recognition
E Track Changes
Manage the files that Mastercam tracks, and customize how

Track

You can also open files by:

» Dragging a Mastercam file or third-party compatible file from Windows Explorer and dropping it in
Mastercam’s graphics window.

» Dragging and dropping a file onto the Mastercam desktop icon to open a new instance of Mastercam.

Goals

+ Open a non-Mastercam file.
» Export a Mastercam file.

» Use Zip2Go files.
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Exercise 1: Opening Non-Mastercam Part Files

Importing files from other applications is similar to opening native Mastercam files. Depending on the file, you
might need to specify how Mastercam imports elements of the file. In this exercise, you convert a SOLIDWORKS
(.sldprt) file to a Mastercam part. You do not need SOLIDWORKS to open or convert a SOLIDWORKS file.

1. Select File, Open. Select Computer, then Browse.

©

Open

@ Recent Documents Recent Folders
T - |
Computer
L] comp =
Browse

The Open dialog box displays. Browse to the tutorial parts folder.
2. Inthe Open dialog box, select SOLIDWORKS Files ("*.sldprt"; "*sldasm"; "*slddrw") from the drop-down.

~ GSDLI[}WDRK’S Files (*.sldprt;*.sh VD

Options Open Cancel

The dialog now displays only SOLIDWORKS parts.
3. Select SW_PART.sldprt, which was provided with this tutorial.

4. Select Options.

File name: | SW_Part. SLOPRT ~ | SOLIDWORES Files (*.sldprt;™.sh

Options Open Cancel

The SOLIDWORKS File Parameters dialog box opens.
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You can use these options, which change based on the file type, to control how files are read into the
Mastercam database.

SOLIDWORKS File Parameters >

Import
(®) Solids

(] Attempt to heal solids

[ ] Use surface stitching to import solids

[ ] Create hole operations

[1Import solids history from SOLIDWORKS files
() Timmed surfaces

10000

w Lrl Lrl Lrl

[]Edge curves

Scale: User Specific w

[ ] Use system color for imported solids
[Import hidden entities

Import Mastercam toclpaths from SOLIDWORES files

File Information

Product: SOLIDWORKS Version: 2020
Extents:
X 150.00000 Entities: 1
LE 125.00000 Size: 243364
R 50.00000 Date: June 24, 2021

| Q9 e

5. Select OK without making changes.
6. Select Open in the Open dialog box.
Select Don’t Save if you are asked to save changes to the current Mastercam file.

Mastercam converts and opens the part.

7. Click Outline Shaded and toggle Translucency off to view the part as a solid.

@6 o@e o
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The part displays as shown below.

You learn more about the graphics window and views in later sections of the tutorial.
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@ NOTE:

To learn about converting multiple non-Mastercam files at the same time, click File, Convert,
Import Folder. Select the help button in the Import Folder dialog box.

C\Users\mega

Convert

-— Migration Wizard
/ Use this function to migrate files from previous versions of Mastercam to the late
Migration

Wizard

. Import Folder

Use Import Folder to impert files from one folder to ancther and autematically cc

Import
Folder

- Export Folder

, & Use Export Folder to convert Mastercam files to CAD files of supported formats.
port

Folder

Exercise 2: Exporting a Single File

When exporting, you might need to set a few options to guarantee a successful conversion of the file data for your
purposes. In most cases, you need only select the software package to which you are exporting the file. In this
exercise, you learn to convert a Mastercam file to a different format.

1. Open 2D_CHAMFER_MM.mcam, which was provided with this tutorial. If prompted to save changes to the
current Mastercam file, select Don't Save.
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2. Select File, Save As, and then click Browse.

©

Save As

El:' Computer Recent Folders

- |
r-
Browse

The Save As dialog box opens.

% NOTE:

You can also click the Save As button on the Quick Access Toolbar.

3. Select StereoLithography Files ("*.stl") from the Save as type drop-down list.

AR 0 CHAMFER_MM.stl

Save as type: |5tereul_ithugraph3r Files (*.stl}

4. Select Options.

File name: | 20_CHAMFER_MM.st!

Save as type: |5temuLithuglaph3r Files (*.stl)

1e Folders Options Save

The Save as an STL File dialog box opens.
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5. Select the ASCII option.

Save as an 5TL File >
(®) Binary () ASCI

(® World coordinates

Current WCS

Resalution : 0.02

Lnits Current units ~

9|6

6. Click OK to close the Save as an STL File dialog box.

7. Click Save in the Save As dialog box.

Chapter 4: Working with Files

8. Mastercam saves the file in ASCII StereoLithography format, which allows you to view it with any text editor,

such as Notepad, as shown below.

| 2D_CHAMFER_MM.stl - Notepad — O

File Edit Format View Help
kolid ascii
facet normal 8.999958 -8.889159 @.000898
outer loop
vertex -123.794837 -34.717775 -
2548888
vertex -123.795738 -34.925888 -
12.7880608
vertex -123.791743 -34.488819 -
12.7eeeea
endloop
endfacet
facet normal B.999623 -8.827474 ©.000896
outer loop
vertex -123.779759 -34.852785 -
12.7880608
vertex -123.787623 -34.383388 -
2548888
vertex -123.791743 -34.488819 -
12.7880608
endloop
endfacet
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@ NOTE:

To learn more about exporting multiple Mastercam files at the same time, click File, Convert,
Export Folder. Select the help button in the Export Folder dialog box.

©

Convert

C\Users\mega

Mew
-— Migration Wizard
Open /
. Use this function to migrate files from previous versions of Mastercam to the late
Migration
COpen in Editor Wizard
Merge
- Import Folder
Save I Use Import Folder to impert files from one folder to ancther and autematically cc
mport
Folder
Save As
Save Some - Export Folder
\ Use Export Folder to convert Mastercam files to CAD files of supported formats.
Zip2Go Export
Folder
Print

Exercise 3: Using Zip2Go

The Zip2Go Wizard gathers and compresses the current Mastercam part data into a .MCAM-CONTENT, .Z2G, or .ZIP

file. It scans the machine groups in your current file and captures information such as your Mastercam
configuration, machine definition, post files, tool and material libraries, and other files associated with your part.
This is useful if you are trying to share information with other users or Technical Support.

For information about each file type, see the following table.

File Type Benefits

Can be dragged and dropped into Mastercam. This unzips the files to their proper location

within the default folder structure. To view the files inside, rename it to a .zip.

.MCAM-CONTENT

Can be unzipped by anyone to view contents. These maintain the original file structure inside

Z2G and .ZIP _
the compressed file.

In this exercise, you run the Zip2Go Wizard to compress a Mastercam part file and all the files associated with it into
an .Z2G file.

1. Open BRACE.mcam, which was provided with this tutorial.

If prompted to save changes to 2D_CHAMFER_MM.mcam, choose Don't Save.

84



2. If necessary, click Outline Shaded on the Status Bar to view the part as a solid.

3. Select File, Zip2Go.

©

Change
Recognition

o

Track
Changes

L=

Change Recognition
Compare the geometry of two

Track Changes

Manage the files that Mastercar

AutoSave

Configure Mastercam to autom
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The Zip2Go Wizard opens.

Welcome to the Mastercam Zip2Go Wizard

Use the Zip2Go Wizard to create or extract a compressed file package that allows you to easily share part files and submit to technical support. Refer to Help for more
information.

Build a file package in Mastercam,

< Create
Compress your Mastercam files into an MCAM-CONTENT, Z2G, or ZIP package.

= Edit
Open an MCAM-CONTENT, Z2G, or Zip package to add or remave files.

Extract a file package into Mastercam.

= Extract
Extract an MCAM-CONTENT, Z2G or ZIP file.

Help Cancel

4. Click Create.

< Create
Compress your Mastercam files into an MCAM-CONTENT, Z2G, or ZIP package.

The File Options page displays information about the files that will be saved in the Zip2Go archive. Select the
file types that you want include and deselect file types that you do not want to include in the compressed file.
You can also remove specific files from the archive. For this tutorial, keep the default settings and files
selected.
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57 Zip2Go Wizard x
Create File Options
Select the file types and machine groups you want to include in your compressed package. Click Finish to save the file package and dlose the Zip2Go Wizard. Click
File Options Next to modify the file package.
Manage Files
4 || File types 4 [ ] Group types
Part files ] min
Operation Library files [] Lathe
Machine Definition files [] Router
Control Definition files [] wire
Post files ] Mill Turn
Tool libraries
[] Machine Simulation files
Mill-Turn machine environments
Material files
[] ATP files %
[V1 Support files
Name Path Type Modified Remove
Medical Clip.mcam CAMill 300 Mastercam Part File  1/23/2023 2:57 PM x
Mastercam. Workspace C\Users\\ OneDrive - CNC Software, Inc\Documents  WORKSPACE File 1/14/2023 5:52 PM x
mcamxm.config chusers) .onedrive - cnc software, inc\documents\mr  Mastercam Config Fil:  1/18/2023 11:16 AM x
Mastercam.FT C\Program Files\Mastercam 2024 FT File 1/9/2023 1211 AM x
nethasp.ini Ci\Program Files\Mastercam 2024% Configuration setting:  1/8/2023 2:20 AM x
Zip2Go. XML CilUsers! ‘AppData\localTemp\Mastercam 2024\LP XML Document 1/23/2023 2:58 PM x
Zip2Go_(Medical Clip).TXT CiUsers! “AppData\Local\Temp\Mastercam 2024\LP. Text Document 1/23/2023 2:58 PM x
Zip2Go_FileReport.TXT Ch\Users! \AppData\Local\Temp'\Mastercam 2024\LP. Text Document 1/23/2023 2:58 PM x
Zip2Go_HASP.TXT CilUsers! ‘AppData\localTemp\Mastercam 2024\LP  Text Document 1/23/2023 2:58 PM x
Zip2Go_HASP.XML CiUsers “AppData\LocalTemp\Mastercam 2024\LP. XML Document 1/23/2023 2:58 PM x
Zip2Go_SystemReport. TXT C\Users' \AppData\Local\Temp\Mastercam 2024\LP. Text Document 1/23/2023 2:58 PM x
e

Concel | [ Brevious | New | [ Eish

5. Click Next.

Zonfiguration setting:  1/04/2022 2:06 PM X

Cancel || Previous Mext Finish |
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The Manage Files page displays the files that Zip2Go will include in the package. On this page, you can
review, add files and folders, as well as remove specific files from the package.

57 Zip2Go Wizard X
Create File Options
Select the file types and machine groups you want to include in your compressed package. Click Finish to save the file package and dlose the Zip2Go Wizard. Click
File Options Next to modify the file package.
Manage Files
4 (] File types 4 [] Group types

Part files M
Operation Library files athe
Machine Definition files
Contral Definition files Wir

Post files Mill Turn
Tool libraries

[ Machine Simulation files

Mill-Turn machine environments

Material files

[] ATP files I}
V] Support files
Name Path Type Modified Remove
Medical Clip.mcam CAMill 300 Mastercam Part File  1/23/2023 2:57 PM X
Mastercam. Workspace C\Users\, OneDrive - CNC Software, Inc\Documents  WORKSPACE File 1/14/2023 5:52 PM X
mcamxm.config chusers) .onedrive - cnc software, inc\documents\my  Mastercam Config Fili  1/18/2023 11:16 AM X
Mastercam.FT Ci\Program Files\Mastercam 2024' FT File 1/8/2023 1211 AM X
nethasp.ini C\Program Files\Mastercam 2024\, Configuration setting:  1/9/2023 2:20 AM X
Zip2Go. XML CilUsers! ‘AppData\localTemp\Mastercam 2024\LP. XML Document 1/23/2023 2:58 PM X
Zip2Go_(Medical Clip). TXT C\Users \AppData'Local\Temp'Mastercam 2024\LP. Text Document 1/23/2023 2:58 PM X
Zip2Go_FileReport.TXT Ch\Users! ‘AppData\Local\Temp'Mastercam 2024\LP.  Text Document 1/23/2023 2:58 PM X
Zip2Go_HASP.TXT ChlUsers! ‘AppData\LocalTemp\Mastercam 2024\LP.  Text Document 1/23/2023 2:58 PM X
Zip2Go_HASP.XML C\Users \AppData'LocalTemp'Mastercam 2024\LP. XML Document 1/23/2023 2:58 PM X
Zip2Go_SystemReport.TXT Ch\Users! ‘AppData\LocalTemp'Mastercam 2024\LP.  Text Document 1/23/2023 2:58 PM X
Help Cancel Previous Next Finich

6. Click Finish to display the Save As dialog box, where you can name the newly-compressed file package and
save it.

By default, Mastercam creates a zipped file with a .MCAM-CONTENT extension in the selected folder. Choose a
destination and change the file type to .Z2G in the Save as type drop-down.

7. Click Save.
File name: | [slifalelSrade -
Save as type: | Files (*.Z2G) w
# Hide Folders Save Cancel

Mastercam creates a compressed file in the destination folder.

8. Close Mastercam without saving your changes or leave the file open for the next exercise.

You have now completed this chapter of the Mastercam Basics Tutorial. In the next chapter, you learn more about
viewing your part.
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Chapter 5

Viewing Your Part

Mastercam provides several tools and methods for changing the appearance of the geometry and toolpaths in the
graphics window. In this chapter, you learn to view your part, use materials, analyze your part, and create and use
Viewsheets.

Goals
« Fit all entities in the graphics window.
» Use zoom functions to magnify your view of selected entities.
« Dynamically rotate and pan entities in the graphics window.
» Create a Viewsheet.
» Select materials.

« Analyze your part.

Exercise 1: Changing Standard Views

In this exercise, you learn how to look at your part from different sides and fit it to the graphics window.

1. Open ANGLEBLOCK-MM.mcam, which was provided with this tutorial. The part opens in Isometric (WCS) view.
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2. On the View tab, select the Show Axes drop-down. If necessary, deselect World, Cplane, and Tplane. Only
W(CS remains selected.

|E| Groups |< TZ T ;ﬁy :L—F .
|E| Recent Functions & - K

Show Show Show Show Snap Rotation
Axes * Gnomons™ Tool - Grid to Grid Position

Warld ] & Grid | Controller

¥ WS

Cplane
Tplane

3. On the View tab, select Show Axes or press [F9] to toggle the display of the WCS axes.

The coordinate axes show the origin and the part orientation to help you visualize the part in 3D space.

4. On the View tab, select the Show Gnomons drop-down and deselect Cplane and Tplane. Only WCS remains
selected.

Kk T- Vi @

Show Show Show Show Snap Rotation

Axes= Gnomons~ Toal = Grid to Grid  Position
Selected planes troller
¥ WS
Cplane
Tplane

Display Cplane and Tplane in corners

¥  Show plane names

+  Use origin colars

90



Chapter 5: Viewing Your Part

5. On the View tab, select Show Gnomons. The WCS gnomon displays. The text indicates that the WCS is set to

the Top plane, and the Cplane and Tplane are also set to Top.

Top
(WCS,C,T)

6. On the View tab, select Top.

My Tab Wireframe Surfaces Solids

Unzoom 50% L] 1sometric = Ia]j' Rotate

Unzoom 20%

. ;
°F i/ Front =

Graphics View

The part changes to show the Top WCS view.

{ Right Wi = Cplane -

Model Pre

g

Section

View =

X

Top
(WCS,C,T)
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7. You can also use the right-click menu to change the view. Practice switching to other views using this menu.

Zoom Window
}3 Unzoom 308
@ Dynamic Rotation
H Fit
@ Top (wcs)
& Front (WC5)
G Right (WCS)
T Isometric (WCS)

GView 4 Mamed b
W quick Cplane & Back (WCS)
% Delete Entities & Left(wCs)

G5 Bottom [WCS)

\') Analyze Distance... @5 Isometric Reverse [(WCS)
\? Analyze Entity Properties... @- Trimetric (WCS)

8. When finished, return the part to Isometric (WCS) view.
9. Click Show Gnomons to turn off the display of gnomons in the graphics window.

10. On the View tab, select Unzoom 80% to reduce the size of the part on the screen.

ﬁ-:r_]j' Isometric =

@ Right i

[ [ Top . ;
. i Front = [
Zoom Graphics

11. On the View tab, select Fit. You can also press [Alt+F1].

ﬁ) Unzoom 50% Eﬁ'
‘E!Unznumﬂme fﬂ"

Top

e &
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The part now fills the entire graphics window.

X otoursor - o8z ° 2 e
%/ :
- X
[
»
.
! "
q
E
z

1 e E e

@ =="10 4:1!%‘(",'%

@ NOTE:

Fit and several other Zoom commands are also available in the right-click menu.

Exercise 2: Zooming In and Out
In this exercise, you practice different techniques for viewing areas of detail in your part.

1. Place your cursor in the upper left quadrant of the graphics window.

2. If your mouse has a middle mouse wheel, spin it back and forth to dynamically zoom in and out. Hold the
shift key to zoom faster. You can also press the [Page Up] and [Page Down] keys on your keyboard to zoom
in and out.

3. Click Fit or press [Alt+F1] to fit the part to the screen.
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4. On the View tab, select Window.

File Home My Tab Wireframe

9 Unzoom 50% ﬁ]j' Is

H Unzoom 80% -l [_‘ﬁ' R

Top .
i F

Zoom

5. Click and drag a window around the upper section of the part as shown below.

-
I_

U

6. Click to set the zoom window. Mastercam scales the selected area to fit the entire graphics window.

7. Right-click the graphics window and choose Fit.
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8. Select the circle on the front of the angle block.

9. Onthe View tab, choose Selected from the Fit drop-down menu.

File Home My Tab Wireframe
: B
@ Unzoom 50% ﬁ &G Isc
ﬁ Unzoom 80%a - rfﬁ' Ril
Fit  Window Top .
i Fr

] Fit m

The selected entity is scaled to fit the graphics window.

i AutoCursor - 43z * x- 8- Eae
¥ & v ¥

] /
i /
{ /
\ r

.Y \ P
1 (oo 8 o b ”
| - - o702
S e

.
% e |

@ (== "m0

10. Press [Esc] to clear the selection.

11. Right-click in the graphics window and select Fit.

Exercise 3: Rotating Your Part View

Chapter 5: Viewing Your Part

This exercise shows how to set the action that your middle mouse button or wheel performs in the graphics window

(rotate or pan). You also learn to dynamically rotate entities in the graphics window.
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1. Select File, Configuration.
The System Configuration dialog box opens.

2. Expand the Screen group, and select View.

----- Printinig

----- Reparts

=) Screen

' Grid
Yiewzheat

----- Selechion
----- Shading

3. If necessary, set Middle button/wheel to Rotate.

Middle button/wheel
() Pan

[ ] Reverse wheel

By choosing Rotate, Mastercam sets dynamic rotation as the primary function when you click and hold the
middle mouse button or mouse wheel.

4. Click OK to close the System Configuration dialog box. If prompted to save the current settings to
configuration file, click No.

5. Set up the part in the graphics window, as follows:
a. Set the Gview to Front.
b. Click Unzoom 80%.

6. Middle-click in the graphics window where indicated below and continue to hold down the middle mouse
button or wheel as you move the mouse slowly in a circular motion.

.=H=.

This action rotates the part in space about the selected position and lets you see it from any angle.
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Chapter 5: Viewing Your Part

7. Let go of the middle mouse button/wheel to finish rotating the part.

The axes symbol (gnomon) in the graphics window changes as you rotate the part. The Gview name in the
graphics window no longer displays because you are not in a standard view.

F F
L,— L
X X
Front

8. Return the view to Isometric, and fit the part to the screen.

You can also select Dynamic Rotation from the right-click menu and follow the on-screen prompts to rotate
the part.

Exercise 4: Panning Your Part
In this exercise, you change your view in the graphics window by using shortcut keys.

1. Hold down the [Shift] key, middle-click in the graphics window where indicated, and continue to hold down
the button/wheel while you move the mouse up, down, side to side, and around.

It appears that you have picked up the part and are moving it in the direction of the mouse. However, the
entities are not physically moved in space, only the display changes. The GView does not change as you pan
the entities.

2. Release the [Shift] key while still holding down the middle mouse button/wheel and you can rotate the part.
Press the [Shift] key again to return to panning.

3. When you finish panning, release the [Shift] key and the middle mouse button/wheel at the same time to exit
the function.

Exercise 5: Analyzing Your Part

Mastercam's Analyze functions allow you to measure distances between lines, arcs, points, angles, and more.
Depending on the type of entity you analyze, these functions can provide information about the following:

« Entity type

* Coordinates
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e Operations

* Measurements

» Associated toolpaths
The Analyze functions also allow you to edit features, such as the entity’'s name, measurement units, and levels.
In this exercise, you use the Analyze functions to view and edit the properties of your wireframe.

1. Setyour view to Isometric and press [Alt + F9] to show gnomons.

Top
(WCS,C,T)

(7] Arc Center Points 2 ? %7 Dynamic ~ @ Check Solid =

'

Analyze| Analyze Analyze ) o
Entity |Distance Toolpath ™ Chain ~ Statistics

I:I Endpaints i:-_’Angle & ? 20 Area =

i Blank -

Display Analyze
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Chapter 5: Viewing Your Part

3. Inthe graphics window, select the line shown in the following image.

The Line Properties dialog box opens. Analyze Entity recognizes you have selected a line and shows
information such as the X / Y / Z endpoint coordinates, the angle, and the level.

NOTE:
Analyze functions report position coordinates in relation to the Cplane origin.

4. Enter -1.0 in the Y position field for the start and end points.

Line Properties >
g L
x
0] | v
0.0 Z (300
*+ 2

5. Press [Enter].
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Top
(WCS,C,T)

The line moves -1 units on the Y axis.

@ NOTE:
Top-Level Editing allows you to adjust the geometry of your part from within the graphics window.
To learn more about Top-Level Editing, see "Editing Geometry from the Top-Level" on page 49 in this

tutorial or visit the Mastercam Help Center.

6. From the Style drop-down, select the option shown below.

£ |1 |1

Sty'le —— |

Width

L T

The selected line changes to dashed. You can also change its level, color, and width. Use this function to

adjust units and precision as well.
7. Click Cancel or press [Esc] to exit the Analyze Entity function. If you select OK, the changes are applied.

100



Chapter 5: Viewing Your Part

8. On the Home tab, expand the Analyze Distance drop-down and select Analyze Distance Along Curve.

\? \? ? "\?Dynamicvgi

Analyze Analyze  Anal A angle - g

nalyze na 2 nalyze - . |

Entity |Distance~ Toolpath % Chain = [E]:
\E Analyze Distance

|2 Analyze Distance Along Cunre]

The Analyze Distance Along Curve dialog box appears.

9. Select the circle shown below.

The Analyze Distance Along Curve dialog box updates to show information about your selection. It lists the
distance along the curve and the angle information.
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Units
Millimeters W
Predsion
M. 123 A
Distance 15.708
Start Angle 0.0
End Angle 0.0
Sweep Angle 1 360.0
Sweep Angle 2 0.0

v, [2)

You can use the Units and Precision drop-downs to adjust the measurements.
10. Press [Esc] to exit the function.

11. Press [Alt + F9] to turn off the gnomons.

Exercise 6: Using viewsheets

Mastercam allows you to view your part in different orientations with viewsheets. Viewsheets make viewing a large
part easier, as you can set up multiple viewsheets with different views.

Additionally, you can create a bookmark for individual viewsheets and/or create groups of multiple viewsheets. A
viewsheet bookmark holds the settings for the view displayed in the viewsheet. When you save your part file,
Mastercam stores the viewsheet settings, including the bookmark, along with the part. When working with your
part, you can restore the viewsheet to its saved view by restoring the bookmark.

In this exercise, you create a viewsheet.

1. If necessary, fit the part to the graphics window, and set the view to Isometric.

2. Onthe View tab, select On/Off to toggle viewsheets on.

. — ]H Save Bookmark
+
Rotation On/Off | Mew
Position -
Contraoller Viewsheets T
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A tab named Viewsheet-1 appears at the bottom of the graphics window.

t
X
Viewsheet-1 | }

3. On the View tab, select New from the New drop-down.

—y

. [ ] -_ ]HSEveBnnkmark
- g

MELUTE D a

Rotation On/Off MNew

'_‘

Position

Controller

Copy
Rename

Mastercam creates Viewsheet-2.

Chapter 5: Viewing Your Part

4. Right-click Viewsheet-2 and select Rename from the menu. Enter Right View and press [Enter] to accept

the name.

Mew viewsheet

Group >

Ungroup

C"nrw
Rename

Delete

Save viewsheet as bookmark
Delete viewsheet bookmark

Restore from viewsheet bookmark

Settings

Viewsheet #1

‘J‘lewsh eets Help
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5. Right-click in the graphics window, and select Right to view the part from the right.

Window

;E} Unzoom 80%
@ Dynamic Rotation

H Fit
[ﬁ' Top

& Front

[ Right
T Isometric

GWiew 4

WP Quick Cplane

=

¥ Delete Entities

‘@ Analyze Distance
\:’ Analyze Entity

6. Select Viewsheet-1 again.

Viewsheet #1 | Right View =

Notice that this viewsheet still shows the isometric view. Each viewsheet can contain different views and
planes.
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7. Right-click Viewsheet-1 and select Settings.

Mew viewsheet

Group
Ungroup

Copy

Rename

Delete

Save viewsheet as bookmark
Delete viewsheet bookmark

Restore from viewsheet bookmark

:

Viewsheets Help

The Viewsheet dialog box opens.

Chapter 5: Viewing Your Part

Viewsheet

Save to Viewsheets

20 /3D

Selected planes
Gvigw

WCS

Construction plane
Tool plane

Displayed planes
Section view planes
[ 5ection wiew settings
Z depth

[ Automatically restare bockmark settings

Enable All

Colars

Active level

Paint ztyle

Line style

Line width

Surface denszity

[ Dizplay mode

Stock dizplay

tlotion contraller rotation pozition
[] &dvanced toolpath dizplay settings

Dizable &l

v | R | ?

Use the Viewsheet dialog box to indicate which settings to save to the viewsheets. You can also access the
viewsheet settings on the Viewsheet page of System Configuration.

8. Click OK to exit the Viewsheet dialog box without making changes.
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Exercise 7: Using Materials

In this exercise, you use Mastercam's material options to make your parts look more realistic.
1. Open the GPS SUCTION MOUNT.mcam file, which is included with this tutorial. If prompted to save

ANGLEBLOCK-MM.mcam choose Don't Save.

2. Press [F9] to hide the gnomon axes.

3. Onthe View tab, select Material.

@ Wirefra... ~ ' :a |E| Toolpath
() outline Shad... v @@ = [tz solids
Advanced
0 Material @ Display ~ |E| Planfs|
Appearance i | Toolpaths M

4. Inthe graphics window, click the base of the part to select it.
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5. On the Home tab, select the Set Material drop-down to display the material type gallery.

¥ Non-As
# v |— *| 3D Z (0.0 = x E
X Duplice
- - - A - I : N ic - DEIEtE%
' i : 1 ﬁ e I:i'._l i gl 109 : Suctic Fntities “-yndele
Metal
Attributes pelete

0000000
o 000000
PPTTTTTY

6. Inthe Metal group, select the Metal Level 4 from the gallery.

a

Xar
— - Z |00 2D . @
¥
x
= = = * B0 = . o Delete
B -4 -5 -8 &y = 2109 Suctic e % |

Attributes D

©00@600
00000606
G

il |7
i

B
k
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The part's base changes to the selected material, a semi-reflective metal.
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8. On the Home tab, select the Set Material drop-down and select Plastic Level 7.

¥,
- D z oo . X"‘

®
X
-4 -gg e iaE By 2= P 109: sudtic - Fai::t; %

0005000

Plastic

:000000@
TTTTTT

9. Select the casing behind the clamp face, and choose Glass Level 3 from the Set Material drop-down.

ttributes

EL NS
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10. Rotate and zoom in on the part to view the different types of material.

11. On the View tab, toggle Material on and off to see how the material options affect the part.

12. Before moving to the next exercise, ensure that Material is toggled off.

Exercise 8: Managing Section Views

In this exercise, you use Mastercam's section views to show cross sections of a part.

1. Load the file SPOOL BODY.mcam, which is included with this tutorial. If prompted to save
GPS SUCTION MOUNT.mcam choose Don't Save. If you see a message for switching units, click OK to allow the

change.

2. Onthe View tab, select Section View to toggle section views on.

Advanced
Display «

Toolpaths

Top Section
gNamed - EE View v 0 Material

Graphics View Appearance

@‘ Efjh Isometric ~ ﬁﬁ" ﬁ @ Wirefra... » ' =¢'
& Front~ Wi (O outline Shad... ~ ¢ =
®
i

Section views only show in the graphics window when the feature is on.
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3. Select the Planes tab to bring the Planes Manager to the front.

N i -

(e

[}
O
-
4 L]

1
(]
@
¥}
[&T]

T

I
(5]
(4]
(%)

Comment

Toolpaths Solids | Planes | Levels Recent Functions

4. Inthe Top plane row, click the Section column. The X indicates that there is now a section view for the plane.

Planes v I X
+-m-Q-=cP -5 PE-@

Mame G WCs| C | T |Offset Disp... -
"> | w.lc|T]

Front

Back

Bottom

Mastercam displays a cross section of the part, using Top as the clipping plane, as shown below.
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5. On the View tab, click the Section View drop-down.

b=
T Rotate @ Q 'Translucenq E
E = Cplane t @ Backsice =
s Wireframe Outlige Material Adva
m ave = Shadefl = Disp
View « Stock Models Iﬁupearance i Toolpi
1 x « Shaded Entities

«  Wireframe Entities

v Toolpaths
on Show Caps __/‘

Use this menu to select what types of entities are affected when using section views.

6. From the Section View drop-down menu, select Show Caps. Mastercam adds solid caps to the sectioned
areas, as shown below.

You can also access Section View from the Planes Manager's toolbar.

Planes v 1 X
+-m-Q-=cg o-S5{B)K-@
MName G WCSs C T |Offset Disp... Section
o Top M., C T X
Front
Back
Bottom

7. Close Mastercam without saving your changes or leave the file open for the next exercise.

You have now completed this chapter of the Mastercam Basics Tutorial. In the next chapter, you learn more about
levels.
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Chapter 6

Working With Levels

A Mastercam file can contain separate levels that include wireframe, solids, surfaces, drafting entities, and other
part data. Organizing your geometry by levels lets you control which areas of the part are visible and which entities
you can select in the graphics window. This control makes it easier to work with the file and helps prevent you from
affecting areas of the drawing you do not want to change.

You can create and name unlimited levels and set any one to be the active, current working level. For each level you
create, you assign a unique number and, optionally, a name. Mastercam'’s Levels Manager provides a central
location where you can view and create levels, and set their properties.

Goals

» Explore the Levels Manager.

* Modify the Levels Manager display options.
e Turn level displays off and on.

» Change the active level.

» Create a new level.

* Move selected entities to a different level.

Exercise 1: Exploring the Levels Manager

In this exercise, you explore the Levels Manager and modify some display options.

1. Open LEVELS_PART.mcam, which was provided with the tutorial, and save it with a new name. If prompted to

save SPOOL BODY.mcam choose Don't Save. If you see a message for switching units, click OK to allow the
change.

Tool contarment bourdary

Sclid body

/— Stock detirition

Edge projection
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2. Click the Levels tab.

Mame: Wireframe
Level set:
Display: 1 Used
1 Mamed
(® Lsed or named
i1 Range
E

Toolpaths Solids Planeecent Functions

If the Levels tab is not displayed, select Levels on the View tab to toggle the display.

' Translucency

@ Backside = >|<
Advanced Show

Display = Axes T

I Toolpaths T~ Managers Dis
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The Levels Manager shows all levels that are in the current part file, their display status, and the number of
entities per level.

Levels v X
+ QTS T O

Mumber & | Visible | MName G Level Set | Entities

Wireframe

@ _-__

Mumber: e il

MName: Wireframe
Level set:
Display: lsed
MNamed
® Used or named 0
Range
1 100
A. The check mark in the Number column indicates the current active level.
B. Settings for the active level display in this section.
C. Click any column heading to sort the levels grid. Click again to change the sort order.

D. Use these options to choose which levels are displayed in the grid.

3. Select Hide level properties to hide the property controls in the lower section of the Levels Manager and
maximize the space allotted to the levels grid.

Le vels I v X
Mumber & Visible | MName Level Set | Entities
Wireframe

--——

4. Select Hide level properties again to show the controls at the bottom of the Levels Manager.

115



Mastercam 2025 + Mastercam Basics Tutorial

5. Select Display options, Contrast rows to apply shading to every other row used in the grid.

Levels v X
+aAsS=c 200

MNumber & |Wishle |1 ¥ Active level is always visible

v X Only active level is visible

I Arrow keys set active level
lgnore blgnked entities in count

6. Select Display options and deselect Contrast rows to remove shading from the levels grid.

In the next exercise, you learn to toggle the display of different levels.

Exercise 2: Showing or Hiding Levels

In this exercise, you change the graphics window display by hiding and showing the levels. To select or otherwise
work with an entity in the graphics window, the level it occupies must be visible.

1. In the Visible column for the 2: Solid level, click once to hide the level.

Levels v 1 x
+ AT o-@
Mumber & fVisible | MName evel Set | Entities
¥ 1 ¥ Wireframe 29
2 Solid 1

The part display in the graphics window updates accordingly.

Tool comtoarmenT boundory

/ Etock detrmiton

Ecipe propecton

2. Click again in the Visible column to display the solid.
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3. Try turning off the display of level 1: Wireframe.

When Active level is always visible is selected in Display options, you cannot hide the active level.

Levels v 7 ox
-4 o &
+ass O ]
Mumber & | Visihle »  Active level is always visible
¥ 1 ¥ Only active level is visible
2 X Arrow keys set active level

Ignaore blanked entities in count

Contrast rows

Turning off the display of the active level while you are working in that level is not recommended. However, it
may occasionally be necessary.

4. Select Display options, and deselect Active level is always visible.

Levels v I x
+aAs=-EHE-@
Mumber & | Visible Active level is always visible
¥ 1 ¥ Only active level is visible
2 X Arrow keys set active level

Ignaore blanked entities in count

Contrast rows

5. Use Turn all levels off and Turn all levels on to toggle the display of all levels.

Levels v 1 x
Mumber & Visible @ MName Level Set | Entities
v 1 ¥ Wireframe 29

6. Select Active level is always visible again.

7. Make sure all levels are visible before continuing on to the next exercise.

Exercise 3: Changing the Active Level

Any geometry that you create is always placed on the active level. There can only be one active level at a time, but

you can change the active level as often as necessary to work with the part. In this exercise, you change the active
level using several methods.
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1. Inthe Levels Manager, click once in the Number column of level 2: Solid to set it as the active level.

Levels v 1 x
+ A= 0-@
Mumber & Visible @ Mame Level Set | Entities

kA Wireframe 29

NOTE:
The level field located on the Home tab also shows that level 2: Solid is the active level.

Cut
o cu # v |m—— v |—— -+ 3D Z |00 - x

(s copy
= = - A - - Eal 2= i - Delete
B Copyimage | =~ 2 " & & - B = | D250 Entities

Clipboard Attributes ] Organize

2. Onthe Home tab, select the Level drop-down and select 1 : Wireframe to make it the active level.

¥ Non-Associative DD
b
2 X O

§ Duplicates -

VAT . Delete Hide/Unhide
21 wiretrafll | PEEE X Ungelete Entity -

Level number Level name
2 Solid

In the Levels Manager, a check mark appears in the Number column for level 1.

Levels v I x
+ QS cE 0-@

|sible Mame Level Set | Entities
' 1 Wireframe 29

2 X Salid 1

3. Inthe Levels Manager, turn off level 2's visibility.
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4. Position the cursor anywhere in the row for level 2: Solid, right-click and choose Make active.

Levels v 1 x
+ A TS r o-@
Mumber & Visible @ Mame Level Set | Entities

! j 29
e —
Make active

Renumber level

A check mark appears in the Number column for level 2.

Level 2: Solid is also visible because the Levels Manager display option Active level is always visible is

selected.
Levels v B x
+ QAT = O-@
Mumber af Visible “Wame Level Set | Entities
1 X wireframe 29
2 ¥ alid 1

Exercise 4: Creating a Level and Assigning Entities
In this exercise, you create and name a level, and then assign entities to that level.

1. Inthe Levels Manager, select Add a new level.

Levels v 3 x
FErz=-B0-0
Mumber & Visible @ Mame Level Set  Entities
¥ 1 X Wireframe 29
2 X Siolid 1

Mastercam adds a new level to the Levels Manager grid and sets it as the active level.

Levels v B x
+ AT o-@
Mumber &  Visible | Mame Level Set | Entities
1 kA Wireframe 29

¥ 3 X 0
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2. Enter Tutorial for the Name.

Number: 3
N
Game: | Tutorial )
-y
Level zet:
Display: lzed

The Levels Manager grid updates to show the new name. Although level names are optional, descriptive
names are helpful.

3. Make level 1: Wireframe the active level.
4. Use the Display options in the lower section of the Levels Manager to control the visibility of levels.

 Click Used and notice that level 3: Tutorial is no longer visible because there are no entities assigned

toit.
Levels v X
+ AT = -@
Mumber &« Visible | Mame Level Set | Entities
¥ 1 X Wireframe 29
2 ¥ Solid 1

Mumber: i
Mame: Wireframe
Level set:

Digplay:
amed

|sed or named
Range
1 100

Toolpaths Solids Planes Recent Functions | Levels

» Click Used or named to restore visibility of all levels.

5. Make level 3: Tutorial the active level.
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6. On the Wireframe tab, select Point Position.

File Home Wireframe Surfaces 5S¢

"I'.f:\‘r /"' /'LineF‘araIIeI
+

Bolt Line )
Position = J Circle Endpoints > Line Closest =

| Line Perpendicular

Points Lines

The Point Position function panel opens.

7. Click a few times in different places in the graphics window to create points.

Kk Salicd bocly

8. Click OK in the Point Position function panel to exit the function.

Point Position B ox

Basic
Entity A

9. Inthe Levels Manager, verify that the new geometry was created on level 3: Tutorial. The number of entities

is not 0.

Levels v 7 %
+QATscB -0
Mumber & Visible | MName Level Set  Entities
1 ¥ Wireframe 29

¥ Solid h|

2
G 3 kA Tutaorial Ei:)
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Your number of points may be different than what is shown.
10. Practice turning level displays on and off and changing the main level.

When you are ready, turn on the visibility for all levels and continue with the next exercise.

Exercise 5: Moving Entities to a Different Level

In this exercise, you create a new level by moving entities from one level to another. You can use the same basic
procedure to copy entities to a different level.

1. Inthe Levels Manager, enter 4 in the Number field, and then enter Labels for the Name.
Levels v X
+ AT = o-@

Mumber & Visible | Mame Level Set | Entities

1 ¥ Wireframe 29

2 X Solid

3 ¥ Tutarial a
¥4 X Labels 0
Mumber: 4
MName: Labels
Level sat:
Display: lJsed

Mamed

» lUsed or named

Range
1 100

Toolpaths Solids Planes Recent Functions | Levels

The new level, 4: Labels becomes the active level.
2. Make level 1: Wireframe the active level.

3. On the Home tab, select Change Level.

Haome Wireframe Surfaces Solids Maodel Prep Mesh Drafting Transform Art Machine

do Cut X, Hon-Assoclative oo

- A v |m— e | 3 Z 0.0 - - ]

U copy % Duplicates =

- B .@3 . 4 . - 08 G = | B w .| Delete Hid &/ Unhide
8 Copy Image 1 - @ N : Wirefrar Entities -
Clipboard Attributes M Organize Delete

Mastercam prompts you to select which entities to move.
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4. Inthe graphics window, choose the Select all advanced Quick Mask.

5.

Q

The Select All dialog box displays.

In the Select All dialog box, do the following:
a. Select the Entities checkbox.
b. Expand Drafting and select Labels.

Errt'rtieD

Colar
Level
Width
Style
Pairt

00000 OR)

Miscellaneous

I ¥ |
-] “wireframe

-] Curves on Surfaces

E-[] Surfaces
=[] Crafting
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6. Click OK.

In the graphics window, Mastercam highlights all of the labels, indicating that they are selected.

7. Press [Enter] or choose End Selection.

The Change Levels dialog box opens.

@ NOTE:

You can also use general selection methods to preselect entities before choosing the Change Level
option. When you preselect entities, Mastercam does not prompt you to select additional entities
and you advance directly to the Change Levels dialog box.

8. In the Change Levels dialog box, do the following:
a. Select Move.

b. Deselect Use Active Level to allow the entities to be moved to any level.
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c. Enter 4 for Number.

r

Change Levels

Level

Mumber:

(O Copy

[] Use Active Level

4

Mame:

Level set:

on

LS

Labels

Select...

[ | Force visibility
Off

 ©

(2]

9. Press [Enter].

Chapter 6: Working With Levels

10. Inthe Levels Manager, verify that level 4: Labels now contains the four label entities that were on level 1.
Level 1: Wireframe contains four fewer entities.

Levels

+ASE=crE0-@

Mumber &  Visible

v 1 X
2 X
3 X
4 X

11. Save your part.

Marne

Wireframe
Solid
Tutorial
Labels

Level Set

Entities
25

1

8

4

You have now completed this chapter of the Mastercam Basics Tutorial. In the next chapter, you learn more about

views and planes.
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Chapter 7

Understanding Views and Planes

Mastercam locates your work in three-dimensional space. This means that geometry and toolpath positions are
expressed in terms of three coordinate axes: X, Y, and Z. Each axis has a positive and negative direction.

In previous chapters, you learned about standard views and planes. In this chapter, you learn more about creating
your own planes and using them for geometry creation.

Goals

¢ Understand views and planes.

e Customize the Planes Manager.

 Adjust follow rules.

» Create a new plane using the dynamic gnomon.
¢ Create a new plane using the Planes Manager.

» Use a new plane for geometry creation.

Views and Planes
You use views and planes in Mastercam for many drawing and machining purposes.

A plane is any two-dimensional slice of a 3D coordinate system. Examples of planes include the XY plane in a 3D
coordinate system, or a face of your part, no matter its angle.

Aview is a plane with an origin and orientation. For example, the Left side view and Right side view are both
aligned with the same plane; but a clockwise arc in one view is a counterclockwise arc in the other view.

Mastercam includes a number of predefined views that you explored in " Changing Standard Views" on page 89.
These include Top, Front, Right, Isometric, and others.

The work coordinate system (WCS) refers to the alignment of the coordinate system itself. You can choose to align
the coordinate system axes with any plane you wish. When this happens, you map the XY plane to the plane of the
view. The origin of the view becomes your new (0,0,0) point. The view becomes the Top plane in the new working
coordinate system.

This section introduces some ways planes are used and some ways to access them. You can use views and planes
for three main functions:

» Graphic views (Gviews)—A Gview determines the angle from which you are looking at the part in the
graphics window.

« Construction planes (Cplanes)—When you draw geometry, the Cplane is the plane in which the geometry is
created. This does not have to be the same as the Gview. For example, you can look at your part in Isometric
Gview, while drawing geometry in the Front Cplane.
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» Tool planes (Tplanes)—This is the plane that is typically normal to the tool axis. Tplanes are only used when
creating toolpaths. Tool planes determine the tool orientation. In almost all cases, your Cplane will be the
same as your Tplane (the most common exceptions are mill/turn operations).

You use the Planes Manager to select, edit, create, and manage planes.

Exercise 1: Exploring the Planes Manager

In this exercise, you open the Planes Manager and experiment with display options.

1. Open BRACE.mcam, which was provided with the tutorial. Save the file with a new name.

2. Select the Planes tab to bring the Planes Manager to the front.

Comment:

Toolpaths Solids | Planes | Recent Functions  Levels

If the Planes tab is not displayed, select Planes on the View tab to toggle the display.

Machine View

WTraﬂsIucenc_-.-' =ﬂ' |E| Toolpaths |E| Levels |E| Groups

.Backside |E| Multi-Threading |E| Recent Functions
Advanced s
Display = |E| Art 2
% | Toolpaths Ts Managers

3. Inthe Planes Manager, select Show Gnomons.

Planes v 1 ox
+-m-Q-=cBo 5 9(EP
Mame G WCS C | T |Offset Disp... Sectio
g- | Jw.jc it | | |
Frant
Back

The gnomon for the currently selected plane displays in the graphics window whether or not the Planes
Manager has focus. Additionally, if the Display column is selected for a particular plane, the gnomon will also

display.
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4. Click the Follow rules drop-down and select the options shown in the following image. With these settings,
when you change the Gview of a plane, the Cplane and Tplane follows.

Planes v 3 x
_ e —p N
+-m-a-=cBo{GE0-E-0
Name c wes ¢ Cplane/Tplane follows WCS
vfmp W C Guiew follows WCS
Front ¥ Cplane follows Guiew
Back v Tplane follows Cplane
Bottom » Cpl =Top in | tric Gi
Right side \_ plane = Top in lsometric Gview j

oo

5. Click in the G column of the Bottom plane to set the Gview to bottom. Note that Cplane and Tplane follow the
Gview as directed by the follow rules.

Planes v 3 x
+1.‘1Q1:rﬂ151ﬂ1t¥1@|
MName G WCS C T |Offset Disp... Sectic
+ Top Wes
Front
framt:
oo [ 6 | Jc|T] ]
1ant side
Left side

6. From the Follow rules drop-down, deselect Cplane follows Gview.

Planes * oA
- Q= S P-E-@

Cplane/Tplane follows WCS

Mame G WCS C

v Top WCs Guiew follows WCS
Front Cplane follows Gview
Back v Tplane follows Cplane

" Bottom G C _ R
Right side v (Cplane = Top in lsometric Gview
Left side
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7. Click in the G column of the Top plane to set the Gview to Top. Note that Cplane and Tplane no longer follow
the Gview, as directed by the new follow rules.
Planes v 7 ox
+-m-Q-=cB -5 95
T

Offskt Disp... Sectic

G WCS
G WC5S

Left side

Ten

8. Click the Follow rules drop-down, and reselect Cplane follows Gview.

9. Click in the G column of the Iso plane to return the Gview to Isometric. Note that Cplane and Tplane remain
in the Top plane as the follow rule, Cplane = Top in Isometric Gview is selected.

Planes v 1 x
-m- Q=B H-S-F--@

MName G WCS C T |Offset Disp... Sectic

+ Top wes o T
Front
Back
Bottom
Right side
Left side

g el [ [ | |

Iso reverse
Trimetric

10. Select Show Gnomons to toggle it off.

Exercise 2: Creating a New Plane Using the Dynamic Ghomon

In this exercise, you create a new plane using the dynamic gnomon. When creating a new plane using this method,
the gnomon is initially oriented to the current Gview.

1. On the View tab, select the Show Axes drop-down and select WCS, Cplane and Tplane.
Transform Art Machine Wiew

—

:_n_ |E| Toolpaths |E| Levels |E| Groups L Show Ax..~ y j:—F

= |E| Solids |E| Multi-Threading |E| Recent Functions World 2mp.. ¥ K

Advanced Show Snap
Display~ |tz Planes [t Art v WCs k¥ Grid to Grid
Toolpaths & Managers ¥ Cplane E Grid M

v Tplane |
iK1 AutoCursor ~ ¥z *oy \F‘_=J|:|~ %

2. Toggle Show Axes on, if necessary.
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3. Onthe View tab, select Window.

Zoom

4,
5.
o~
Ie7)
LS
TR g
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6. Click and drag the gnomon so that it matches the orientation shown below. Click to set the position.

z

The New Plane function panel opens.

7. To change the orientation of the Dynamic Gnomon, hover over the blue arc until the dial appears.
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8. Click the blue arc and rotate the gnomon from within the dial until it is at 90 degrees. Click to set the location.
(Rotating within the compass snaps in angular increments.)

Or, you can enter 90 in the on-screen edit field, and press [Enter] twice.

9. Inthe New Plane function panel, enter DYNAMIC PLANE for the Name.

New Plane B ox

GEE Advanced

Mame ~

(/oYNAMIC PLANE )

e ——

Parallel Planes ~

Maone

10. Click OK to close the New Plane function panel.

11. DYNAMIC PLANE appears in the Planes Manager. Click in the Cplane column of DYNAMIC PLANE.

Planes v 3 x
+-m-Q-=cB &S T L@
Mame G WCS C | T | Offset Disp... Section
o Top ...
Front
Back
Bottom
Right side
Left side
4 Iso G

Iso reverse
Trimetric

v EREE I I I I I
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The Cplane and Tplane axes indicate the location of the new plane origin as shown below.

Exercise 3: Creating a New Plane Using Planes Manager

In this exercise, you use Planes Manager to create a new plane aligned with the slanted face of the part. You add it
to the list of system planes.

1. Press [F9] to turn off the axes.

2. Press [Alt + F1] to fit your part to the graphics window.

3. Inthe Planes Manager, select Create a new plane, From solid face.

Planes v I X
= QO -=r HG-5-9-E-@

)
@i _From geometry... C T Offset Disp... Sectic

1 . |
tEJ From solid face... } c T

ﬁ? Fram entity normal...

Relative to WCS k
& quick Cplane...

ﬁ? Dynamic...
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4. Select the slanted face of the part, shown below:

The Select plane dialog box opens.

5. Inthe Select plane dialog box, click the arrows to cycle through the possible planes. For most applications, it
make sense to have +Z pointing away from the part.

Select plane =

Flane 1 of 8

&)

6. Cycle to the plane shown below.

Select plane et

Plane 2 aof 8

¢
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7. Click Save this plane and exit in the Select plane dialog box.
The New Plane function panel opens.
8. Inthe New Plane function panel, enter the following:
a. Enter FACE OF PART for Name.

b. Select Cplane for Set As.

New Plane 1 X

Basic atsifEl =]

Mame ~

| FACE OF PART

Parallel Plames ~

Mane
Crigin w
Worlk Offset w

Set As ~

[ Jwcs
Tplane

L] Displayed
|:| Section
[ | Locked

[ ] Linked:

9. Under the Origin group, click Reselect to return to the graphics window to choose a new point for the origin.

Parallzl Planes -

MNone ¥
OCrigin #
X 2400 -
¥: 206.41824 -
i 128.25 <
Style Absolute

Incrementa

NCS ongin

Reselect

Reset
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10. Select the point at the lower-right corner of the face.

7

1
FACE OF PART -

Chapter 7: Understanding Views and Planes

11. Click OK in the New Plane function panel to create a plane. Your new plane, FACE OF PART, displays in the

planes grid.

Planes v 1
+-m-Q-=cF H-S-P-E-@

Marme G WCS5 C | T Offset Disp... | Section

v Top WCS
Front
Back
Bottom
Right side
Left side
o Iso G
Iso reverse
Trimetric
DYMAMIC PL...

v RS I S I I

Exercise 4: Using a Custom Plane for Drawing Geometry

In this exercise, you create geometry using the new Cplane. You see that the new plane determines the orientation

of the geometry. You then set the Gview to the new plane.

1. Inthe Planes Manager, click in the WCS column for the FACE OF PART plane.

Lo s
" Iso G
Iso reverse
Trimetric
DYMAMIC PLAME

\gFaceorpart | | wes Jc ] | ] |
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2. On the Wireframe tab, select Circle Center Point.

My Tab Wireframe Surfaces Solids Model Prep

“} Arc 3 Points

/+ //LiﬂEF'ErE||E|

+

Line
‘ndpoints - Line Closest =

| Arc Tangent

L. Line Perpendicula

Center Point '_J Circle Edge Point ~
Lines Arcs
The Circle Center Point function panel opens.

3. On the Selection Bar, select Origin from the AutoCursor drop-down.

i AutoCursor| = ¥ "5y E - E - & EE_ .

! AutoCursor
( _+_Origin )
Face Center
., Endpaint

g -
# Intersaction

# Midpaint

4. Inthe Circle Center Point function panel, enter 80.0 for Radius and then click OK.

Circle Center Point 7 x

® ©®©O®

Basic
Entity ~
Method: ® Manual

() Tangent
Center Paint ~

Reselect

Size

Diameter: | 160.0 s 0

[ | Create Additional Geometry #

Surface
Sheet solid
Mesh
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5. On the View tab, select Show Axes. If necessary, click the drop-down and ensure that all options are selected.

View

Eﬂ' |E| Toolpaths |E| Levels |E| Groups * L; T’?‘

Y]

o] Solids [t Multi-Threading [tz] Recent Function ak
Advanced Show SHow Show
Display = E Planes E Art

Axes = Gnomons~ Tool =
Toolpaths T~ Managers +  Waorld |y M

¥ WCS

v  Cplane

\ ¥ Tplane

6. The axes that define each view display in a different color. Since Cplane and Tplane are the same, the axes
display as dotted lines. Experiment by turning individual sets of axes on and off.
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7. Inthe Planes Manager, click in the G column of the FACE OF PART plane to set the Gview.

You are now looking straight down into the face of the part. The Gview is aligned with the custom plane that
you just created.

FACE OF PART
(WCs,C,T)

8. Press [F9] to turn off the axes.

9. Save your part.

You have now completed this chapter of the Mastercam Basics Tutorial. In the next chapter, you learn more about
working with chain selection.
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Working With Chain Selection

Chaining is the process of selecting and linking pieces of geometry. Use chains to create a toolpath, surface, or
solid. Chains are a subset of selection. However, chains are directional. Cutting tools follow the direction of the
chain. The following image shows a clockwise wireframe chain. The tool will move in the direction of the green
arrow.

]

There are two modes for chaining: wireframe and solid. The mode determines the selection options that are
available to you. You typically use wireframe chains when you wish to create a toolpath without first creating the
associated solid. Use solid chains on solid models.

Goals

» Use Curve All Edges to create wireframe from a solid.
» Explore wireframe chaining.

» Create and modify solid chains.

@ NOTE:

This chapter requires a Mill machine. If your Mastercam license does not allow access to Mill, you can
either:

e Download Mastercam Learning Edition and use it to complete the exercise:
https://signup.mastercam.com/demo-hle.

e Read through the exercise.

Exercise 1: Creating Wireframe from a Solid

In this exercise, you use Curve All Edges to create wireframe for a solid.

1. Open the file SOLID CHAINS.mcam, which is included with this tutorial, and use Save As to save it with a new

name. If you see a message for switching units, click OK to allow the change.
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2. Inthe Levels Manager, select Add a new level.

Levels v 1 ox
HazszsrEo-0

Mu... & Visble MName Level Set  Entities

1 X 1

Level 2 appears and becomes the active level. Note that it has 0 entities. The solid body remained on level 1.

Levels v 3 ox
+ A== H-@
Mu... & Visible  Mame Level Set | Entities
1 X 1
) :

{E? Raster to Vector
|_"'_-|., Stair Geometry
[0] Door Geometry

\
vl
Trim to
Entities -

The Curve On All Edges function panel opens.

4. Window select your entire part.

5. Click End Selection.

6. Click OKin the Curve On All Edges function panel.
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Curve On All Edges rox

®

Basic

The solid body has a wireframe outline.

7. Inthe Levels Manager, hide level 1.

Levels v I X
+ AT cF 0-@

Mu.,.., & FisiVNamE Level Set | Entities
1 ¥ 1

¥ 2 ¥ 130

The solid body is no longer visible. The wireframe remains.
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8. Save your part.

Exercise 2: Exploring Wireframe Chaining

In this exercise, you explore wireframe chaining methods.

1. On the Machine tab, select Mill, Default.

Machine

L=l T4 B IST SHE o1 T

Mill | Lathe Mill-Turn Wire Router Design Control  Machine Material Mill Tool = Backplot WVerify Simulate Generate  Creat

- - - - Definition Definition Manager
Default chine Type Job Setup Simulator Y Post

| Manage List... - I %

This sets your machine type, which is the first step in creating a toolpath. You will create a complete toolpath
in the next chapter. For this chapter, you will follow the first steps of toolpath creation in order to practice
chaining.

2. On the Toolpaths contextual tab, select Contour from the 2D gallery. If you are not using a Mill, select any
toolpath available to your machine that brings up the Wireframe Chaining dialog box.

Toolpaths
= h & 2 &9 5 S ® S 22
i=— B - %
Contour Drill Dynamic ... Face - OptiRough Pocket Project Parallel - Curve Swarf Milli... Unified
2D 3D Multiaxis
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e Chaining dialog box opens.

Wireframe Chaining

() Cplane @30
Selection Method
) A
______ L
+

In W ait
Selection
“§ [ D
O | =
Branches
Start/End
@O

X

Chapter 8: Working With Chain Selection

3. Check that Wireframe and 3D are selected beneath Mode. These options allow you to select wireframe
entities defined in the X,Y, and Z axes.

Wireframe Chaining *

tode

() Cplane

4. Be sure that Chain is selected under Selection Method.

Selection Method

@ o
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Selection methods make it easier to select the desired geometry. For example, when Chain is selected in 3D
mode, Mastercam pauses chaining at all branches and prompts you to select the next entity.

5. Click the line shown below.

A chain appears with three arrows:
» Green appears at the start of the chain and shows the direction of the cutting tool.
» Red shows the default chaining direction.
» Blue shows alternate chaining directions.

These arrows allow for guided chaining. Guided chaining uses the Next, Previous, and Adjust buttons to
control your chain.

@ NOTE:

You can customize your chain-related colors in the Colors page of the System Configuration dialog

System Configuration

----- Analyze
----- CAD Colar: |
[+ Chaining
[ Colors l—— Auto-highlight Py
_____ Communications Background [grau;llent start)
Background gradient end
(- Converters Calculable field
----- Default Machines
[ Dimensions and Notes Chain highlight
s ’ Chain preview material crosshatch
[+ Files ; . : ;
| Chain preview material region
""" Genera Chain preview motion region
[ On-5creen Controls Chain preview tool containment
----- Planes DNSTUCOoN ongin
----- Post Dialog Defaults Ed%e motion v
box. | | i Printing i
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6. Click the Next button twice to continue your chain around the base of the wireframe.

Eranches
< e
Start/End
i< 4|

Each time you click Next, the chain continues in the default direction indicated by the red arrow.

7. Inthe Wireframe Chaining dialog box, click Adjust.

Branches
| 4 > |
—_— —_—
Start/End
4 (4

Adjust changes your default chaining direction. The red arrow of your chain switches direction.
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8. Click Next. Your chain continues up the corner edge of the wireframe.

9. To undo the most recent addition to the chain, click Previous.

Branches
- o |
E[=

10. Click Reverse to switch the direction of your chain, as well as the start and end points.

Start/End
4 >
14'ml €>

I a

@ NOTE:

When chaining to create a toolpath, clicking Reverse changes the start point of your toolpath and

direction of your cutting tool.
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11. Press [Esc] and click No to exit the toolpath function.

20 Toclpaths

0 Do you wish to keep this operation?
1 - Contour (2D) - [(WC5: Top] - [Tplane: Top]

Exercise 3: Exploring Solid Chaining

In this exercise, you create and edit a solid chain.

1. On the Levels tab, make level 1 active and visible. Click in the Visible column of 2 to make the level not

visible.
Levels v 7 %
+ AT cFH-@

Mu... & Visible Mame Level Set  Entities

o EH O I I PO
2 130

2. On the Toolpaths contextual tab, select Contour from the 2D gallery. If you are not using a Mill, select any
toolpath available to your machine that brings up the Solid Chaining dialog box.

Toolpaths

s B 5 @€ 9 53 8 b &5
= I - %

Contour Crrill Dynamic ... Face ~ OptiRough Pocket Project Parallel ~ Curve Swarf Milli... Unified
3D Multiaxis

2D
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The Solid Chaining dialog box opens. It shares many similarities with the Wireframe Chaining dialog box.

Solid Chaining X
b ode
RI[@] &
(O Cplane @ 3D

Selection Methad

9 [ o
& || @
L
L

Cavities &l v
Selection

[ A
Brarches

el =
Stat/End

I« >l
©
0[O0 ][@]

The default selection modes for solid chaining are Loop and Face.

3. Deselect all modes except Face.

N
D
3
b

Cavities Al e

Selection kethod

A
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4. Select the four faces in the following image.

The green arrow appears on the last chain created.
5. Click Display all selection arrows.

Selection
"

N

S
o

Branches

A green arrow appears to indicate the direction of each chain.

6. Select Reverse to reverse the direction of all selected chains.

Start/End
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7. Click Unselect to get rid of the selected chains.

Selection

X

8. Change the selection method to Loop. Be sure to deselect Face.

N
D
3
9

Selection Method

e e

Cavities All

9. Hold down [Ctrl] and click on the edge shown below.

[Ctrl + click] allows you to select matching holes or fillets on a part. All circles on the same face as the
original selection become chained.
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10. Click OK to accept the chains.

The 2D Toolpaths - Contour dialog box opens. This is where you program a toolpath. You can also edit
chains here.

11. Click Select chains under Chain geometry.

%ell Chain geome

Sald model

Show,..

Side clearance 0.0

Chain Manager opens.
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12. Expand Solid Chain 1 and select the first Loop. Yellow arrows identify the loop on the part.

=¥ Chain Manager *

= ﬁ Solid Chain 1
EI‘ Loop
EI‘ Loop

EI‘ Loop
EI‘ Loop
[

[al4>] |=

Chaining tolerance: 0.0001

13. Right-click the first Loop and select Reverse.

= Chain Manager =
= Solid Chain 1 [%
[fj‘ Loop Add
[f‘_j‘ Loop ]
[:LI‘ Loop Change side
[f‘_j‘ Loop Rechain all
> Resync all

Reverse order

Sort options...

Analyze
Chaining tolerance

Edit

Delete

Rechain single

Reverse

Start point

Mastercam reverses the loop. The others maintain their original chaining direction. Your other option is to
double-click on the desired chain to reverse it.
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Use the right-click drop-down in Chain Manager when you want to analyze, edit, name, and make other
changes to your chains.

14. Click OK to accept the new chains.

| |
Chaining tolerance: 0.0001

You return to the 2D Toolpaths - Contour dialog box. After chaining, the next step in toolpath creation is to
set parameters. You will do this in the next chapter.

15. Click Cancel to exit the dialog box.

o(o]oie

16. Select No to discard your toolpath.

20 Toolpaths

o Do you wish to keep this operation?

1 - Contour [2D) - [(WCS: Top] - [Tplane: Top]

E Yes i | Mo

17. Save your part.

You have now completed this chapter of the Mastercam Basics Tutorial. In the next chapter, you learn more about
the creating toolpaths.
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Chapter 9

Introduction to Toolpaths

As a CAD/CAM program, Mastercam creates both the geometry and toolpaths needed to machine your part and
achieve your project goals. Toolpaths are the routes along which the cutting tool is instructed to travel. To
effectively meet the needs of users, Mastercam is capable of creating toolpaths that range from simple to complex.

For example, the following image shows a 2D milling toolpath.

2

One of the most important features of Mastercam is associativity, which is the link between the part and the
toolpath. When the part changes shape or moves, the associated toolpaths adapt and change as well. If there is a
part design change, associativity ensures that the toolpaths just require recalculation, rather than being completely
reprogrammed.

To create toolpaths, input specific information such as the machine type, tool specifications, and size and shape of
your material. You also select a toolpath type and set the feeds and speeds at which your part will be machined.

Mastercam turns this information into G-code (sometimes known as NC-code) to be read by a CNC machine.
Depending on the type of machine and your part, this process may be entirely automated or may require occasional
assistance from the machine operator.

Goals

» Choose a machine and set up stock.
» Select a toolpath and geometry.

* Set parameters.
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» Backplot and verify.

e Post the partfile.

NOTE:
This chapter requires a Mill machine. If your Mastercam license does not allow access to Mill, you can
either:

» Download Mastercam Learning Edition and use it to complete the exercise:
https://signup.mastercam.com/demo-hle. Note that you will not be able to complete Exercise 5 with
Mastercam Learning Edition.

e Read through the exercise.

Exercise 1: Selecting a Machine and Setting Up Stock
In this exercise, you select a machine type and set up your stock.

Each machine type allows access to toolpaths specific to that machine. Selecting a machine is the first step in setting
up a toolpath. Once a machine is selected, you set up the stock material boundaries. When you set up stock, you
enter the dimensions and location of your initial material.

1. If necessary, open the part you created in "Working With Chain Selection" on page 141.

2. Gotothe Toolpaths Manager. Machine Group-1 is present because you selected a Mill machine during the
chapter on selection. Machine groups organize your cutting operations by machine.

Toolpaths * 1 X

k “x

Bl oy Machine Group-1
w-[Z| Properties - Mill Default
--am Toolpath Group-1

3. Expand Properties - Mill Default.

4. Click Stock setup.
[El-- Iy Machine Group-1

E||:| Properties - Mill Default
L Files

Tool settings
© L} Stock setup
g Toolpath Group-1

e

Stock is the material from which your part will be cut.

The Machine Group Setup function panel opens to the Stock Setup page.
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<

achine Group Setup 7%

Stock Setup

il selection (0) -
@
]
& = -
+ | @@ 3] %
|
N
.I® Crigin ~
| Rectangular ~
% Cylindrical v
L
Push Pull ~
Stock Plane Transformation !
Current: | Tep v ||
Attributes "‘
Color: F
Preview Settings "‘
Show wireframe entities
[ ] Show stock plane
Engineering Information e

Material: ALUMINUM mm - 2024
Valiaren fea3V 0N

Toolpaths Solids Planes Levels | Machine Gr...| Recent Fun...

The Machine Group Setup function panel (accessed from the Toolpaths Manager) manages machine groups
for Mill and Router machines. It features a top-down workflow, represented by the icons on the left side of
the panel. When creating a toolpath, use the pages in this panel to:

« Select machine files, tool and operations libraries, and operation defaults.

Define the final part (the workpiece) after all machining is complete.
« Configure stock shape, origin, and wireframe.

» Define workholding components, such as fixtures or vices.
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 Set feed calculation, material type, and toolpath numbering.

» Set up simulation options without having to open Mastercam Simulator.

@ NOTE:

Since we are using the default Mill machine in this exercise, we do not need to set up our machine
files in the top (Machine) page. Master Model or workpiece setup, on the next page, is optional.

5. Click Add from a bounding box.

Selection (0) -~

~lelefgEE X

The Bounding Box function panel opens. A bounding box creates a boundary around selected entities in the
graphics window.

6. Select the All shown option to select the part.

Bounding Box 3 X \taCursc

CEE Advanced

Entities ~

(®) All shown

Shape :‘_‘I'
(®) Rectangular
) Cylindrical

Spherical

Wrap

Rectangular Settings ~

Crigin: "2

NOTE:
To display the coordinate axes in the graphics window, press [F9] .

7. Inthe Size section of the Bounding Box function panel, change X to 12.1 and Y to 8.1.
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Sizes
(12

£ (25

This adds a small amount of material to your stock in the X and Y directions. Although your stock values
would ultimately be defined based on the actual stock that you have available, for the purposes of this

exercise we only want to skim off a small amount of material.

8. Click OK in the Bounding Box function panel.

Bounding Box 7 ox

GEE Advanced

9. Click OK in the Machine Group Setup panel.

Machine Group Setup B ox

Stock Setup

10. If necessary, toggle Stock Display and Stock Shading in the Toolpaths tab to see the stock in the graphics

- ChUsershClay. Walnum\OneDr

[ransform Art Machine View Toolpaths

-
i 0 @ = .. 5
4 8 - Sl
Stock | Stock ock
‘arallel ¥ Curve Swarf Milli... Unified ¥ Shading Display Mpdel~ b

"/
hultiaxis Stock

window.

Exercise 2: Choosing a Toolpath and Geometry

In this exercise, you choose a toolpath and chain associated geometry.

1. Inthe Toolpaths tab, turn off Stock Shading.
2. On the Mill Toolpaths contextual tab, select Contour from the 2D group.

File Home Wireframe Surfaces Solids Model Prep Mesh Drafting Transform Art Machine View Toolpaths
- ‘1-\.\_\_\_ [ - .‘1.
4 B - 8 § 53 & b & N
: = -1l %
Contour Crrill Dynamic ... Face ~ OptiRough Pocket Project Parallel ~ Curve Swarf Milli... Unified

2D 3D Multiaxis
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The Solid Chaining dialog box opens.

3. Inthe Solid Chaining dialog box, check that Solids and 3D are selected in the Mode group. In the Selection
Method group, check that Loop and Face are selected. These options allow you to chain the desired
geometry.

Solid Chaining >

L

() Cplane
Selection Method

> > |
N »
G 3

4. Select the chain shown in the following image.

A green directional arrow appears. This arrow shows the direction the tool will follow. Typically, you want the
cutter to move in a clockwise direction so that it will be on the left side of the chain. This is not the case in the
following image.
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5. If necessary, select Reverse to reverse the direction of the arrow so that the part is to the right side of the
green arrow.

Start/End
i< »l
Hfhl fﬂ)

© | Q0 @

Your part is now to the right of the green arrow. Your cutter will be on the left side of the chain.

6. Click OKin the Solid Chaining dialog box.

()o@
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The 2D Toolpaths - Contour dialog box opens. This is where you program your toolpath.

=¥ 2D Toolpaths - Contour

TiH&-O

Flanes

Cut Parameters

& Depth Cuts

e | pad InyfOut

.. Break Through

----- & Multi Passes
& Tabs

oy — Linking Parameters
L Home / Ref, Points

Arc Filter [ Tolerance

............. Canned Text

............. Misc Values

[ Axis Control

Axis Combination

- Rotary Axis Control

[ 16
e

Contour

=2
Pocket Facdng

@

Slat mil

il

Model
Chamfer

Quick View Settings

Tool 1/2 FLAT EM...
Tool Diameter 0.5
Corner Radius 0
Feed Rate 6.4176
Spindle Speed 1069
Coolant Off
ToolLlength 0
Length Offset 239
Diameter Q... 239
Cplane /Tpl... Top
Axis Combi... Default (1)
= edited
2 = disabled

Generate toolpath

Chain geometry
o |

Solid model
5

Side dearance

Avoidance mode

Clearance

Exercise 3: Programming a Toolpath

In this exercise, you program your toolpath by selecting a tool and setting parameters.
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Click the Tool page in the 2D Toolpaths - Contour dialog box.

-
w3 2D Toclpaths - Contour

FR&-@&-
+aa Type
Tool >ta

=]+ Cut Parameters
..... o) Depth Cuts

I

2. Click Filter.

3. Select None to clear filters. Choose Endmill1 Flat from Tool Types.

= Y [ | Filter active

Tool
Tool name: | 1/2 FLAT EMDMILL |

Tool diameter: Corner radius:
Tool #: Head #:
Length offset:

Diameter offset: [ Force tool change

The Tool List Filter dialog box opens. Use this to filter your tools by type.

Tool Types

’
m
E
]

@:%ﬂ:%m@:@:

114
104
< 3P4
o % &
6] 0 |

.
@
)
y
8l

E@:@@m@j

Mone
Operation masking Unit masking
Mo operation masking | | Mo unit masking e

4. Click OK.
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5. Click Select library tool.

o | T  [JFrilter active
Tool
Tool name: [ 1/2FLaT ENDMIL |

Tool diameter: Corner radius:
Tool #: Head #:
Length offset;

Diameter offset: [ Force tool change

The Tool Selection dialog box opens. All tools listed are endmills, which are what you set the filter for. Use
the row headers to sort tools by characteristics such as name, diameter, or flutes.

C:\Users\Public\Docu. . \Mil_Inch.toolds | P

Tool Mumber  Assembly MN... Tool Name Holder Mame  Diameter  Cormer Radius  Leng ™Y
H 1 - 0 CENTER. ... - 0.125 0.0 0.12
H 2 - 00 CEMTER.... - 0.125 0.0 0.11
H 3 - 11 CENTER.... - 0.125 0.0 0.11
H 4 - 1 CENTER ... - 0.125 0.0 0.11 Filter...
H 5 - 12 CENTER.... - 0.1875 0.0 0.17 Filter Active
s - 2CENTER ... - 0,1875 0.0 0.17
6. Select 1/2 Flat Endmill and click OK.
Tool Mumber  Tool Mame Diameter  Cormer Radius  Length  Flutes Type ™
H 233 5/32FLAT ... 10.15625 0.0 0.375 4 Flat
H 234 316 FLAT ... 0.1875 0.0 0,4375 4 Flat
H 285 1/4FLATE... 0.25 0.0 0.5 4 Flat
H 286 5/16 FLAT ... 0.3125 0.0 0,75 4 Flat
H 287 3fBFLATE... 0.375 0.0 0.75 4 Flat
H 288 13/32 FLAT... 0.40625 0.0 0.8 4 Flat
H 289 76 FLAT ... 0.4375 0.0 0.8 4 Flat
H 290 1/2FLATE... 0.5 0.0 1.0 4 Flat
H a4 1737 F AT n o317 mn 1M A Fl=t

You return to the 2D Toolpaths - Contour dialog box.

7. Select the Depth Cuts page.

B 2D Toolpaths - Contour

Y H B

----- Halder

- Cut Parameters
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8. Select Depth cuts.
----- Halder

EI : Cut Parameters
I Sl D =rith Cuits
Lead In/Out

[ ] Depth cuts

bl aw rough step:

Depth cuts divide the total depth into separate cuts.

Chapter 9: Introduction to Toolpaths

9. Change Max rough step to 0.2. This is the maximum amount of material to remove with each rough cut.

Depth cuts
Maximurn rough step: 0.2
Finish
Mumber of cuts:

Step:

fl

Override Feed Speed

[ ]Feed rate B.4175

[]spindle speed 1069

10. Select the Linking Parameters page.

----- . Toolpath Type -
-----  Tool

----- Holder

= Cut Parameters

..... « Depth Cuts

----- Lead In/Out

P Multi Passes

- @ Tahs

= Linking Farameters

i . Paints

----- A Filker ¢ Tolerance
----- Plares
----- Coolant

Depth cut order
@ By contour

() By depth

The Linking Parameters page defines how Mastercam calculates heights and depths. These can be
measured in absolute, incremental, or associative values.

11. Select the check box next to Clearance. Clearance sets the height at which the tool moves to and from the

part.

Absolute

[ lonly at start and end of operation

12. Enter 2.00 and select Absolute for Clearance.

13. Enter the following, as necessary, on the Linking Parameters page.
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B Retract

0.25 4 Incremental w | ()
Feed Flane

0.2 s Incremental | (O
Top of Stock

0.5 -$- Absolute | (0
Depth

0.0 ey Incremental ~ | (0]

« Retract: Enter 0.25 and select Incremental to set the height that the tool moves up before the next
tool pass. Incremental values are relative to other parameters of chained geometry.

» Feed plane: Enter 0.2 and select Incremental to set the height to which the tool rapids before
changing to the plunge rate to enter the part.

» Top of stock: The bounding box you created has populated the Top of stock value to set the height
of the material in the Z axis. Select Absolute to measure from the origin 0,0,0.

» Depth: Enter 0 and select Incremental to set the final machining depth and the lowest depth that the
tool descends into the stock.

@ NOTE:

You can explore the other pages, such as Holder, Lead In/Out, and Break Through. For this tutorial
those settings remain at default.

14. Click OK. The toolpath information appears in the Toolpaths Manager. Your 2D Contour toolpath appears in
the graphics window.

Toolpaths v B X
K Zx
3 [}
(=R Machine Group-1
BD Froperties - Mill Default
¢+ Files
] iy Tool settings
... Stock setup

=~2% Toolpath Group-1

-1y 1-Contour (20) - [WCS: Top] - [Tplane: Top]

.25 Parameters

#290 - 0,5000 FLAT ENDMILL - 1/2 FLAT ENDMILL
Geometry - (1) chains
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@ NOTE:

To edit your toolpath, click on Parameters. The 2D Toolpaths - Contour dialog box will re-open.

=~ :: Toolpath Group-1

EI J 1 Contour (2D) - [WCS: Top] - [Tplane: Top]

T #3290 -0.5000 FLAT ENDMILL - 12 FLAT EMDMILL
1 Geometry - (1) chains

Exercise 4: Backplotting and Verifying

In this exercise, you use Classic Backplot to backplot a toolpath and use Mastercam Simulator to verify the toolpath.
Classic Backplot allows you to see a quick simulation of your toolpaths. Verify allows you to see a more detailed view

of your operations, including simulated material removal.

1. Inthe Toolpaths Manager, check that your 2D Contour operation is selected.

Toolpaths v 1 X
X B IxF- ERBolL 7 @

vl
XM vYaAaLo$ 5@kl ®
El- oy Machine Group-1
EI |:| Properties - Mill Default
{ Files
T & Tool settings
W Stock setup
& Toolpath Group-1
EII o 1-Contour (2D) - [WCS: Top] - [Tplane: Tu::p]l
{  ie—= Parameters
----- 1 #290 - 0.5000 FLAT EMDMILL - 1/2 FLAT EMDMILL
------ 1 Geometry - (1) chains
----- =32 Toolpath - 114.6K (00:00:00) - SOLID CHAINS.NC - Program number 0

2. Click Backplot selected operations.

Toolpaths .
Py Xy Tr Tx Ty - ": ok 7 @
M vaG$ XGE:R I

The following appear in the graphics window:

» Backplot dialog box: Controls the backplot display and allows you to save geometry or settings.
« Play bar: Adjusts the speed of the simulation and allows you to pause, play, and set stops.

+ Tool and holder: Simulate the selected tool and holder.

NOTE:
If you do not see the tool and holder, right-click in the graphics window and select Fit.
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3. Click the Play button or press [R].

M0 _ICRICICTNZ a

The tool and holder follow the toolpath.

4. When the simulation has finished, change the simulation speed by adjusting the run speed slider.

P Wl 2] ~g

5. Press [R] to view the adjusted simulation.

6. While the simulation is running, rotate your part. View the tool as it moves along the toolpath.

Click OK in the Backplot dialog box.

r-;!g'gI3;:|1:Ir.|::all::at }-{w
SO~
<% @ H
| v, |9

7. Reset your view to Isometric and Fit.

8. Select Verify selected operations.
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Toolpaths v pox

Py Xy Ty Tx T5- Eﬁm . 72 @
B vanoc 4 oG DY

Mastercam Simulator opens. Your tool, tool holder, and stock are visible in the graphics window.

9. Click Play.

Performance ——W—— Precision m > » H m

Mastercam Simulator shows the path of your tool and holder. The stock updates as the simulator removes
material from the part.

10. Reset the simulation by clicking Start.

Performance ——W—— Precision m >
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11. Click Play and observe the information in the Move Info pane. One of the benefits of Mastercam Simulator is
that it gives you more in-depth information about your operation.

Move Info * 1 X
4 Move Info
Mave ID 1of 18
Elapsed Time 1.00s
Machine 5_5AXGEN_VMCTTA
Maove Type Rapid Linear Move

Cperation Name Contour
Cperation Numt 1D: 0 (1 of 1)
Tecl Number #290 - 1/2 FLAT ENI
Tool Orientation  0.000; 0.000; 1.000
Teel Tip Position -7.250; -0.500; 2.00(
Axis Values

4 Toolpath Info
Feed Length 46.542
Feed Time Tmin 16.13s
Rapid Length 5.600

12. Exit Mastercam Simulator.

Exercise 5: Post Processing

In this chapter you post process your part file.

Post processing, or posting, refers to the process by which Mastercam converts the toolpaths in your part file to a
format that can be understood by your machine tool's control (for example, G-codes). A program called a post
processor, or post, reads your part file and writes the appropriate NC code.

1. Click Select all operations.

Toolpaths v B ox
Py Bix- EwSmolh 7 @
BXR var 5 Gl &5

2. Click Post selected operations to post the toolpaths for the selected operations. The post processor creates
a machine-readable NC program from the Mastercam file.

Toolpaths v 1 x
Px Xk Ty Tx TF - E"ET- 7 @
BEA vano$ %{Ed- e
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The Post processing dialog box displays. The name of the post processor for the machine you have chosen
displays as the Active post field in read-only mode.

' R
Post processing ey
Select Post
[ fOutput part file descriptor: Properties. ..
@ nC file
() Qverwrite & Edit
0O ask MC extension:
MC
[]5end to machine Communications
[ MCI file
Owerwrite Edit
Ask

b A

3. Click OK. The Save As dialog box opens.

4. Name your NC file and click Save.

File name: | My_Part

Save as typer | NC Files (*.NC)

The file opens in Mastercam Code Expert.
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Home View NC Functions ~ .@
ofy Insert Block Numbers  gf}; Insert Block Skip Send File i 4 q b bi @ i q q b bi E%r
o Remove Block Skip | [%] send

& Remove Block Numbers

GoTo = First Previous MNext Last Mark First Previous Mext Last Single Multi-Stream Al NC
@' Remaove Spaces = Remove Comments Receive St Configuration
Editing Communi... = Syncs Tools Display Utilities
Start Page -
—

2 00000 (MY_PART)

3 (DATE=DD-MM-YY - 19-06-20 TIME=HH:MM - 09:21)

4 (MCEM FILE - USERS\MEGAN.CROWLEY\ONEDRIVE - CNC SOFTWARE, INC\DOCUMENWTS\2021 BASICS & WCS5 PROJECT\SELECTION CHRPTER\S5-66401
5 (NC FILE - C:\USERS\MEGAN.CROWLEY\CNEDRIVE - CNC SOFTWRRE, INC\DOCUMENTS\TEMF ODDS & ENDS\MY PART.HNC)

6 (MATERIAL - ALUMINUM INHCH - 2024)

7 { TZ250 1/2 FLAT ENDMILL | H230 )

H100 G20

H110 GO G17 G40 G4% GBO G380

10  N120 T290 Me

11  N130 GO G90 G54 X-7.25 ¥-.5 R0. 5
12  N140 G43 H280 Z2.

13 N150 E.2

14 N1e0 G1 2Z-2.
15 N170 X-6.75
16 N1BO 3 ¥X-6.25 ¥YO. I0. J.5
17  N180 G1 Y4.

18  N200 G2 X-6. Y4.25 I.25 J0.
13  N210 G1 Xa&.

20 N220 G2 X6.25 ¥4. I0. J-.25
21 N230 Gl ¥-4.

22 N240 G2 XK&. Y-4.25 I-.25 J0.
23 N250 Gl X-6.

il

6.42

24 H2e0 G2 X-6.25 Y-4. I0. J.25

25 H270 G1 YO.

28 H280 G3 ¥-6.75 ¥.5 I-.5 J0.

27 H290 G1 X-7.25

28 H300 EZ-1.8 _

23 N310 GO ZZ.
30 N320 Ms
31  N330 81 G283 Zo.

32 N340 G28 X0. ¥0. RO. [-]
[T« | L]
Find BExtents v
Ready In1/35 Col1 889 bytes 100% - ——F—+

The NC code specifies information such as stops, cutting coordinates, and tool changes. Block numbers
appear in front of each command. Code Expert allows you to sync operations, manually edit code, and switch
NC Configurations.

5. Exit Code Expert.

6. Save your part.
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Conclusion

Congratulations! You have completed the Mastercam Basics Tutorial! Now that you have mastered the skills in this
tutorial, explore Mastercam's other features and functions.

You may be interested in other tutorials that we offer. Mastercam tutorials are being constantly developed, and we
will add more as we complete them. Visit our website, or select Help, Tutorials from the File tab.

Mastercam Resources

Enhance your Mastercam 2025 experience by using the following resources:

Mastercam Documentation—Mastercam installs a number of helpful documents for your version of software in
the Documentation folder of your Mastercam installation.

Mastercam Help—Access Mastercam Help by selecting Help, Contents from Mastercam's File tab or by
pressing [Alt+H] on your keyboard.

Mastercam Reseller—Your local Mastercam Reseller can help with most questions about Mastercam.

Technical Support—Our Technical Support department (+1 860-875-5006 or support@mastercam.com) is open
Monday through Friday from 8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

Mastercam Tutorials—We offer a series of tutorials to help registered users become familiar with basic
Mastercam features and functions. Visit our website, or select Help, Tutorials from Mastercam's File tab to
see the latest publications.

Mastercam University—Mastercam University, an affordable online learning platform, gives you 24/7 access to
Mastercam training materials. Take advantage of our many videos to master skills at your own pace and help
prepare for Mastercam Certification. For more information on Mastercam University, please contact your
Authorized Mastercam Reseller, visit university.mastercam.com/, or email training@mastercam.com.

Online Communities—You can find a wealth of information at www.mastercam.com.

¢ Follow us on Facebook (www.facebook.com/Mastercam), Twitter (twitter.com/Mastercam), and
Instagram (https://www.instagram.com/mastercam/) for the latest tech tips and Mastercam news.

» See Mastercam in action on YouTube (www.youtube.com/user/MastercamCadCam).

» For more information on Mastercam, to find and apply to jobs, and connect with people using
Mastercam, visit us on LinkedIn (www.linkedin.com/company/cnc-software/).

» Registered users can search for information or ask questions on the Mastercam Web forum,
forum.mastercam.com, or use the Mastercam Knowledgebase at kb.mastercam.com.

Contact Us

For questions about this or other Mastercam documentation, contact the Content Development Department by
email at techdocs@mastercam.com.
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Attention! Updates may be available.

Please refer to my.mastercam.com for the

latest downloads.

www.mastercam.com Mm

Mastercam® is a registered tradi k of CNC Software, LLC. All other trademarks are property of their respective owners. 671 Old Post Road
©1983-2024. All rights reserved. Tolland, CT 06084 USA
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